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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the MG3700A Vector Signal Generator 
Operation Manual (Mainframe), MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe), 
MS2690A/MS2691A/MS2692A Signal Analyzer 
Operation Manual (Mainframe Operation), or 
MS2830A Signal Analyzer Operation Manual 
(Mainframe Operation). Please also refer to either of 
these documents before using the equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 
following safety symbols to indicate safety-related information.  Ensure that you clearly understand the meanings 
of the symbols BEFORE using the equipment.  Some or all of the following symbols may be used on all Anritsu 
equipment.  In addition, there may be other labels attached to products that are not shown in the diagrams in this 
manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 

This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions.  Ensure that you clearly understand the meanings of the symbols 
and take the necessary precautions BEFORE using the equipment. 
 
 

 
This indicates a prohibited operation.  The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution.  The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution.  The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note.  The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 

 

MX370101A/MX269901A 
HSDPA/HSUPA IQproducerTM  
Operation Manual 
 
29 November 2004 (First Edition) 
25 November 2014 (11th Edition) 
 
Copyright © 2004-2014, ANRITSU CORPORATION. 
All rights reserved.  No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The contents of this manual may be changed without prior notice. 
Printed in Japan 
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 WARNING 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange 

this software free-of-charge if it proves defective when used as described 
in the operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months 

from the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts 
of God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment 
purchaser.  It is not transferable if the equipment is resold. 
 
Anritsu Corporation will not accept liability for equipment faults due to 
unforeseen and unusual circumstances, nor for faults due to mishandling 
by the customer. 
 
 

Anritsu Corporation Contact 
In the event that this equipment malfunctions, contact an Anritsu 
Service and Sales office.  Contact information can be found on the last 
page of the printed version of this manual, and is available in a separate 
file on the CD version. 
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Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 
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Software End-User License Agreement (EULA) 
Please read this Software End-User License Agreement (hereafter this EULA) carefully before using 
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios, 
etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this 
software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter 
Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment 
(hereafter Equipment) for the purposes set out in this EULA. 
1. Grant of License and Limitations 

1. Regardless of whether this Software was 
purchased from or provided free-of-charge by 
Anritsu, you agree not to rent, lease, lend, or 
otherwise distribute this Software to third 
parties and further agree not to disassemble, 
recompile, reverse engineer, modify, or create 
derivative works of this Software. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer 
this software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for personal 
injury, or any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, arising out of or related 
to your use or inability to use this Software. 

 
 

3. Limitation of Liability 
a. If a fault (bug) is discovered in this Software, 

preventing operation as described in the 
operation manual or specifications whether 
or not the customer uses this software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or exchange the 
software, or suggest a workaround, 
free-of-charge. However, notwithstanding 
the above, the following items shall be 
excluded from repair and warranty.  

i) If this Software is deemed to be used for 
purposes not described in the operation 
manual or specifications. 

ii) If this Software is used in conjunction with 
other non-Anritsu-approved software. 

iii) Recovery of lost or damaged data. 
iv) If this Software or the Equipment has been 

modified, repaired, or otherwise altered 
without Anritsu's prior approval. 

v) For any other reasons out of Anritsu's direct 
control and responsibility, such as but not 
limited to, natural disasters, software virus 
infections, etc. 

b. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs by Anritsu 
engineers necessitated by the above faults 
shall be borne by you. 

c. The warranty period for faults listed in 
article 3a above covered by this EULA shall 
be either 6 months from the date of purchase 
of this Software or 30 days after the date of 
repair, whichever is longer. 
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4. Export Restrictions 
 You may not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by Japanese and 
United States law. In particular, this 
software may not be exported or re-exported 
(a) into any Japanese or US embargoed 
countries or (b) to anyone on the Japanese or 
US Treasury Department's list of Specially 
Designated Nationals or the US Department 
of Commerce Denied Persons List or Entity 
List. By using this Software, you warrant 
that you are not located in any such country 
or on any such list. You also agree that you 
will not use this Software for any purposes 
prohibited by Japanese and US law, 
including, without limitation, the 
development, design and manufacture or 
production of missiles or nuclear, chemical or 
biological weapons of mass destruction. 

5. Termination 
 Anritsu shall deem this EULA terminated if 

you violate any conditions described herein. 
This EULA shall also be terminated if the 
conditions herein cannot be continued for 
any good reason, such as violation of 
copyrights, patents, or other laws and 
ordinances. 

6. Reparations 
 If Anritsu suffers any loss, financial or 

otherwise, due to your violation of the terms 
of this EULA, Anritsu shall have the right to 
seek proportional damages from you. 

7. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with item 5, you shall cease all 
use of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

8. Dispute Resolution 
 If matters of dispute or items not covered by 

this EULA arise, they shall be resolved by 
negotiations in good faith between you and 
Anritsu. 

9. Court of Jurisdiction 
 This EULA shall be interpreted in 

accordance with Japanese law and any 
disputes that cannot be resolved by 
negotiation described in Article 8 shall be 
settled by the Japanese courts. 
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Cautions against computer virus infection 
• Copying files and data 
 Only files that have been provided directly from Anritsu or generated 

using Anritsu equipment should be copied to the instrument. 
 All other required files should be transferred by means of USB or 

CompactFlash media after undergoing a thorough virus check. 
• Adding software 
 Do not download or install software that has not been specifically 

recommended or licensed by Anritsu.  
• Network connections 
 Ensure that the network has sufficient anti-virus security protection in 

place. 
 



 

viii 

 

 

 
 

Protection Against Computer Virus Infections 

Prior to the software installation 
Before installing this software or any other software recommended or 
approved by Anritsu, run a virus scan on your computer, including 
removable media (e.g. USB memory stick and CF memory card) you 
want to connect to your computer. 
 
When using this software and connecting with the measuring instrument 
• Copying files and data 

On your computer, do not save any copies other than the following: 
 • Files and data provided by Anritsu 
 • Files created by this software 
 • Files specified in this document 

Before copying these files and/or data, run a virus scan, including 
removable media (e.g. USB memory stick and CF memory card). 

• Connecting to network 
Connect your computer to the network that provides adequate 
protection against computer viruses. 

 
 
 

Cautions on Proper Operation of Software 

This software may not operate normally if any of the following operations 
are performed on your computer: 
• Simultaneously running any software other than that recommended or 

approved by Anritsu 
• Closing the lid (Laptop computer) 
• Turning on the screen saver function 
• Turning on the battery-power saving function (Laptop computer) 
For how to turn off the functions, refer to the operation manual that came 
with your computer. 
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CE Conformity Marking 
Anritsu affixes the CE conformity marking on the following product(s) in 
accordance with the Council Directive 93/68/EEC to indicate that they 
conform to the EMC and LVD directive of the European Union (EU). 
 

CE marking 

 

1. Product Model 
Software: MX370101A/MX269901A HSDPA/HSUPA IQproducerTM 

 
2. Applied Directive and Standards 
 When the MX370101A/MX269901A HSDPA/HSUPA IQproducerTM is 

installed in the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A, 
the applied directive and standards of this software conform to those of 
the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370101A/MX269901A can be used with. 
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C-tick Conformity Marking 
Anritsu affixes the C-tick mark on the following product(s) in accordance with 
the regulation to indicate that they conform to the EMC framework of 
Australia/New Zealand. 
 

C-tick marking 

 

 
1. Product Model 

Software: MX370101A/MX269901A HSDPA/HSUPA IQproducerTM 
 
2. Applied Directive and Standards 
 When the MX370101A/MX269901A HSDPA/HSUPA IQproducerTM is 

installed in the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A, 
the applied directive and standards of this software conform to those of 
the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370101A/MX269901A can be used with. 
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About This Manual 
■ Associated Documents 
The operation manual configuration of the MX370101A/MX269901A 
HSDPA/HSUPA IQproducerTM is shown below.  

■ If using MG3700A or MG3710A:  

Or 

 

MX370101A/MX269901A  
HSDPA/HSUPA IQproducer™ Operation Manual  

MG3700A /MG3710AVector Signal Generator 
MG3740A Analog Signal Generator Operation Manual (IQproducer™) 

MG3700A  
Vector Signal Generator  
Operation Manual (Mainframe) 

MG3710A Vector Signal Generator 
MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3700A Vector Signal Generator.  

 Or 

 MG3710A Vector Signal Generator MG3740A Analog Signal Generator 

Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3710A Vector Signal Generator and the MG3740A 
Analog Signal Generator .  

 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 

Generator Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator and the Analog Signal 
Generator . 
 

 HSDPA/HSUPA IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of the HSDPA/HSUPA 
IQproducerTM.  
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■ If using MS2690A/MS2691A/MS2692A or MS2830A:  

MX370101A/MX269901A  
HSDPA/HSUPA IQproducer™ Operation Manual 

 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Operation Manual 
(Main Frame Operation) 

MS2690A/MS2691A/MS2692A and MS2830A  
Signal Analyzer Operation Manual (Main Frame Remote Control) 

MS2830A Signal Analyzer 
Operation Manual  
(Main Frame Operation) Or 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Option 020:  
Vector Signal Generator  
Operation Manual  
(Operation) 

MS2830A 
Signal Analyzer 
Vector Signal Generator 
Operation Manual  
(Operation) 

Or 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Option 020: 
Vector Signal Generator 
Operation Manual 
(Remote Control) 

MS2830A Signal Analyzer  
Vector Signal Generator 
Operation Manual  
(Remote Control) Or 

MS2690A/MS2691A/MS2692A and MS2830A 
Vector Signal Generator Operation Manual (IQproducer™)
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 MS2690A/MS2691A/MS2692A Signal Analyzer Operation Manual (Main-

frame, Operation) 

This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A.  

Or 

 MS2830A Signal Analyzer Operation Manual (Mainframe, Operation) 

This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2830A.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Signal Analyzer Operation 

Manual (Mainframe, Remote Control) 

These describe basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A 
or MS2830A.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Operation 

This describes the functions and how to use the Vector Signal Generator 
option. 

Or 

 MS2830A Vector Signal Generator Operation Manual, Operation 

This describes the functions and how to use the Vector Signal Generator 
option. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Remote Control 

This describes how to remotely control the Vector Signal Generator op-
tion.  

Or 

 MS2830A Vector Signal Generator Operation Manual, Remote Control 

This describes how to remotely control the Vector Signal Generator op-
tion. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 

Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator option. 
---------------------------------------------------------------------------------------------- 

 HSDPA/HSUPA IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of the HSDPA/HSUPA 
IQproducer™.  
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This chapter provides an overview of the MX370101A/MX269901A 
HSDPA/HSUPA IQproducerTM. 

 

1.1 Product overview .......................................................... 1-2 
1.2 Product Composition .................................................... 1-3 
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1.1 Product overview 
MX370101A/MX269901A HSDPA/HSUPA IQproducer (hereinafter 
referred to as “this software”) is software used to generate waveform 
patterns conforming to the 3GPP HSDPA/ HSUPA specifications. 

This software requires either of the following environment: 

• MG3710A Vector Signal Generator 
• MS2690A/MS2691A/MS2692A or MS2830A Signal Analyzer with 

Vector Signal Generator option mounted 
• Personal computer (hereinafter, “PC”) 
 
This software generates waveform patterns that support the 
specifications of 3GPP HSDPA/HSUPA with various characteristics. This 
is made possible by the editing/customizing of parameters according to 
its use.  

A waveform pattern created by this software can be output using an RF 
signal after being downloaded into the MG3700A Vector Signal 
Generator , MG3710A Vector Signal Generator , or an 
MS2690A/MS2691A/MS2692A or MS2830A Signal Analyzer with Vector 
Signal Generator option installed (collectively referred to as “mainframe”, 
or “this equipment”). 
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1.2 Product Composition 
The following table lists the model name and specifications of this 
software according to the equipment. 

Table 1.2-1  Restrictions 

Mainframe 

 

Restrictions 

MG3700A MG3710A 
MS2690A 
MS2691A 
MS2692A 

MS2830A 

Software name MX370101A MX269901A 

Maximum Size 
of Waveform 
Patterns 

256 M sample 
512 M sample*1 

64 M sample 
128 M sample*5 
256 M sample*6 
512 M sample*7 

256 M sample 64 M sample 
256 M sample*4 

Transmission 
method of 
Waveform 
Patterns 

LAN, 
CompactFlash 
Card 

External device 
such as LAN, USB 
memory*2 

USB Memory and 
other external 
device*2 

USB Memory and 
other external 
device*2 

Installation of 
this software to 
this equipment 

N/A Possible  Possible*3 Possible*3 

*1: The ARB memory expansion 512M sample (optional) must be 
installed into the MG3700A to use waveform patterns that exceed 
256 M samples. 

*2: Transferring waveform patterns is not required if the waveform 
patterns are created on the equipment using this software. 

*3: Although this software can be installed and run in the 
MS2690A/MS2691A/MS2692A or MS2830A, the measurement 
functions of the MS2690A/MS2691A/MS2692A or MS2830A are not 
guaranteed while this software runs. 

*4: The ARB memory expansion 256M sample (optional) must be 
installed into the Vector Signal Generator option to use waveform 
patterns that exceed 64 M samples.  

*5: The Combination of Baseband Signal (optional) must be installed 
into the MG3710A to use waveform patterns of maximum 128 M 
samples. 

*6: The ARB memory expansion 256M sample (optional) must be 
installed into the MG3710A to use waveform patterns of maximum 
256 M samples.  
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*7: To use waveform patterns of maximum 512 M samples, either of the 
following must be installed into MG3710A: 

• ARB memory expansion 1024 M sample (optional) 

• ARB memory expansion 256 M (optional) and Combination of 
Baseband Signal (optional) 

 

■ Notes on waveform pattern conversion 
The waveform patterns generated with this software varies according to 
the main unit type. If using the waveform pattern to the different main 
unit, you need to convert the waveform pattern.  

For details about how to convert a waveform pattern, refer to each one of 
the following manuals.  

• MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen” 

• MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen”  
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This chapter describes the operating environment for the 
MX370101A/MX269901A. 

 

2.1 Operating Environment .............................................. 2-2 
2.2 Installation/Uninstallation ........................................... 2-3 
2.3 Starting up and exiting the software .......................... 2-4 

2.3.1 Starting Software: When installed  

on other than MG3710A ................................ 2-4 
2.3.2 Starting Software: When installed  

on MG3710A ................................................. 2-6 
2.3.3 Exiting Software ............................................. 2-7 
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2.1 Operating Environment 
The following environment is required for operating the 
MX370101A/MX269901A. 

(1) PC that meets the following conditions 

OS Windows XP/Windows Vista/Windows 7 
CPU Pentium III 1 GHz equivalent or faster 
Memory 512 MB or more 

Hard disk space 

5 GB or more free space in the drive where 
this software is to be installed.  
The free hard disk space necessary to create 
waveform pattern varies depending on the 
waveform pattern size. The free disk space of 
27 GB or greater is required to create four 
maximum (512 Msample) waveform patterns. 

 
(2) If viewing on PC, displays with a resolution of 1024 × 768 pixels are 

best viewed using a small font setting. 
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2.2 Installation/Uninstallation 
This software is included in the IQproducer™ installer. It is 
automatically installed by installing the IQproducer™ that is supplied 
with this equipment or this software. When using a waveform pattern 
created using this software in the equipment, the license file must be 
installed in advance. 

■ Installing/Uninstalling IQproducer™ 

For how to install and uninstall IQproducer™, refer to each of the 
following manuals:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 

■ Installing/Uninstalling IQproducer™ license file 

For how to install license file to MG3700A/MG3710A, refer to the 
following manual:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
5.1 “Installing License File” 
 

For how to uninstall license file from MG3700A/MG3710A, refer to each 
one of the following manuals:  

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.10.10 “Install” 

 MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 
9.4.4 “Install” 

 
Refer to the following manual for details of how to install/uninstall 
license file to MS2690A/MS2691A/MS2692A or MS2830A with Vector 
Signal Generator option.  

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
2.2 “Installation/Uninstallation” 
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2.3 Starting up and exiting the software 
This section explains how to start and stop this software. 

Note: 

The following explanation assumes the use of Windows XP. The 
screen image may differ slightly if not using Windows XP.  

 

2.3.1 Starting Software: When installed on other than MG3710A 
Start this software using the following procedure.  
The example assumes that it is a PC operation.  

<Procedure> 

1. Click Start on the task bar, and point to All Programs. Next, point to 
Anritsu Corporation, point to IQproducer, and then click 
IQproducer. 

 

2. When IQproducer™ starts, the Select instrument screen is 
displayed. 

On the Select instrument screen, select the model of the main unit 
that uses the waveform patterns created by IQproducer™.  

 

Notes: 

 The software does not support MG3740A. 

 To hide this screen and to start with the selected mainframe's 
screen from the next time, select the Don't show this window 
next time check box. 
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3. The common platform screen is displayed when OK is clicked in the 
Select instrument screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

 

Figure 2.3.1-1  Common Platform Screen 

 

4. Click the System (Cellular) tab on the common platform screen, to 
show the System (Cellular) selection screen that supports each 
telecommunication system.  

 

 

Figure 2.3.1-2  System (Cellular) Selection Screen 

 

5. Click HSDPA/HSUPA Downlink or HSDPA/HSUPA Uplink to 
display the main screen. For details of the main screen, refer to 
Chapter 3 “Detailed Description of Functions”.  

Note: 

If Change Instrument is clicked, the Select instrument screen will 
appear each time the software is loaded.  
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2.3.2 Starting Software: When installed on MG3710A 
Start this software using the following procedure.  

<Procedure> 

1. Press  on the MG3710A front panel to display the common 
platform screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 2.3.2-1  Common Platform Screen 

 

2. Click the System (Cellular) tab on the common platform screen, to 
show the System (Cellular) selection screen that supports each 
telecommunication system.  

 

Figure 2.3.2-2  System (Cellular) Selection Screen 
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3. Click HSDPA/HSUPA Downlink or HSDPA/HSUPA Uplink to 
display the main screen. For details of the main screen, refer to 
Chapter 3 “Detailed Description of Functions”.  

Note: 

When this software is installed on MG3710A, Change Instrument 
displays instead of Interface Settings. Clicking Interface Settings 
displays the Interface Setting dialog box. 

 

Figure 2.3.2-3  Interface Settings Dialog Box 

 

Here, you can configure interface-related settings of IQproducer 
and MG3710A. To return to factory defaults, click Default. 

 Row Socket Port Number 

Sets Row Socket port number. Set the same value as that for 
MG3710A.  

 Wait Time 

Sets the wait time between commands. 

2.3.3 Exiting Software 
Stop this software using the following procedure. 
■ When exiting only this software 

To exit only this software without closing the Common Platform screen, 
or other IQproducer™ tools, do one of these below: 

 Click the Exit button ( ) on the tool bar. 

 Select Exit from the File menu. 

 Click the  button on the upper right screen. 
 

 

Figure 2.3.3-1  Exiting Software 
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The operation of the three screen buttons is explained below.  

 

 

Figure 2.3.3-2  Exit Confirmation Window 

 

 Yes Saves current parameters to file and stops this 
software. 

 No Stops this software without saving current 
parameters to file. 

 Cancel or  Cancels the process and returns to the main screen. 
 
When stopping this software using the Yes button, the saved parameters 
are read at the next start and reset for each parameter.  

■ When exiting entire IQproducer™ application 

To exit all tools of IQproducer™ that are running, select Exit on the 
Common Platform Screen. In this case, a dialog is displayed to confirm 
stopping of each running tool.  

 

Figure 2.3.3-3  Exiting IQproducer™ 
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This chapter provides detailed descriptions of this software. 

Notes: 

 The examples and screens used throughout this chapter are 
based on the assumption that the IQproducer™ is activated 
with the MG3700A.  

 The MG3710A, MS2690A/MS2691A/MS2692A, and MS2830A 
functions are described as notes in each item.  
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3.1 Downlink Setup Screen 
3.1.1 Main screen 

On common platform screen, click the System (Cellular) tab, and then 
select HSDPA/HSUPA Downlink to display the main screen. 

 

Menu

Tool buttons

Total Power
 display

Normalize Power
button

Status display

 

Figure 3.1.1-1  Downlink main screen 
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■ File menu 

The File menu contains the following items. 

 

Figure 3.1.1-2  File menu 

 

 Select Option 
Notes: 

 This function is available only when MG3700, MG3710 or 
MS2830 is selected in the Select instrument screen. 

 ARB Memory Expansion (option) is not available for 
MS269xA. Only Memory 256M samples, 1 GB is available.  

 
■ When using MG3700A or MS2830A 

 Select whether the ARB memory expansion option 256Msamples is 
installed. Selecting With Option21 (Memory 512M samples)/With 
Option27 (Memory 256M samples) supports creation of larger 
waveform patterns. If the ARB memory expansion option is not 
installed, the generated waveform pattern may not be able to be 
used. Waveform patterns cannot be created with a size greater than 
256Msamples or 64M samples when Without Option21 (Memory 
512M samples)/Without Option27 (Memory 256M samples) is 
selected. Select either according to the presence of ARB memory 
expansion option. 

Table 3.1.1-1  Available Options for MG3700A or MS2830A 

Model Items 
ARB Memory 

Expansion 

MG3700A 

With Option21 (Memory 512M 
samples) 

1 GB x 2 
memory 

Without Option21 (Memory 
512M samples): 

512 MB × 2 
Memories 

MS2830A 

With Option27 (Memory 256M 
samples) 1 GB 

Without Option27 (Memory 
256M samples) 256 MB 
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■ When using MG3710A 

 The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the Baseband 
Signal Combination Function (option) generates a bigger waveform 
pattern, while selecting the Baseband Signal Combination Function 
(option) generates a waveform pattern. If an uninstalled option is 
selected, sometimes the created waveform pattern may not be 
usable.  

 Set the combination of installed options based on the following 
setting items.  

Table 3.1.1-2  Available Options for MG3710A 

Items Combinations of Options 

Memory 64M samples None 

Memory 64M samples × 2 
Option48 
and 
Option 78 

Memory 256M samples 
Option45 
or 
Option 75 

Memory 256M samples × 2 
Option 45 and Option 48 
or 
Option 75 and Option 78 

Memory 1024M samples 
Option46 
or 
Option 76 

Memory 1024M samples × 2 
Option 46 and Option 48 
or 
Option 76 and Option 78 

 

The maximum size of the generated waveform pattern for each of 
the setting items is shown below.  

Table 3.1.1-3  Waveform Pattern Maximum Size 

Items Maximum Size 

Memory 64M samples 64M samples 
Memory 64M samples × 2 (With 
Option48, 78) 128M samples 

Memory 256M samples 256M samples 
Memory 256M samples × 2 (With 
Option48, 78) 512M samples 

Memory 1024M samples 512M samples 
Memory 1024M samples × 2 (With 
Option48, 78) 512M samples 
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 Recall Parameter File 
Sets the HSDPA/HSUPA Downlink parameters according to the 
setting of the parameter files saved by Save Parameter File. 
 

 Save Parameter File 
Saves the HSDPA/HSUPA Downlink setting parameters to a file. 
 

 Exit 
Exits the HSDPA/HSUPA Downlink IQproducerTM. 

 

■ Edit menu 
The Edit menu contains the following items. 

 

Figure 3.1.1-3  Edit menu 

 

 Channel Edit 
Displays the Channel Edit screen in which the P-CCPCH and 
DPCH parameters are set. This is the same operation with clicking 
the Channel Edit button on the screen. 
 

 HSDPA1 Edit, HSDPA2 Edit, HSDPA3 Edit, HSDPA4 Edit 
Sets the channels related to HSDPA. This is the same operation 
with clicking the Edit button on the screen. 
 

 Calculate Waveform Pattern 
Starts waveform pattern generation based on the settings on the 
screen. 
The number of frames to be generated varies depending on the 
setting conditions for each channel, and the time required for 
generating a waveform pattern also varies accordingly. The number 
of frames to be generated is displayed on the calculation progress 
screen. 
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When a waveform pattern is generated, two files with the 
extensions “.wvi” and “.wvd” are created. When loading a waveform 
pattern to a memory, select the *.wvi file for the target waveform 
pattern. 

When a waveform pattern that uses the FIR filter of the 
MG3700A/MG3710A mainframe is created, a file with the extension 
“.wvc” is created in addition to the *.wvi and *.wvd files. When 
transferring a waveform pattern or loading a waveform pattern to a 
memory, select the *.wvc file for the target waveform pattern. The 
settings for two memories are executed at once by this operation.  

For details of waveform pattern classification, refer to Appendix B 
“Number of Frames to Be Generated”.  

 Calculation & Load  
Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded into the MG3710A waveform memory.  

 

 Calculation & Play  
Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded and selected at the MG3710A waveform memory.  

 



 

3.1 Downlink Setup Screen 

3-7 

3 

D
etailed D

escription
 of F

u
n

ction
s 

■ Easy Setup menu 

The Easy Setup menu contains the following item. 

 H-Set (QPSK or 16 QAM) 
 

 

Figure 3.1.1-4  H-Set (QPSK or 16QAM) menu 

 

 Selects the setting for each H-Set from HSDPA Fixed Reference 
Channels (FRC) specified in 3GPP TS25.101. 
 

 Tables 3.1.1-4 and 3.1.1-5 list the parameters when each H-Set is 
selected. 

 
H-Set 1(QPSK) 
H-Set 1(16QAM) 
H-Set 2(QPSK) 
H-Set 2(16QAM) 
H-Set 3(QPSK) 
H-Set 3(16QAM) 
H-Set 4 
H-Set 5 
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Table 3.1.1-4  FRC H-Set common parameters 

Parameter H-Set1, H-Set2, H-Set3, H-Set4, H-Set5 

Scrambling Code 0 
CPICH ON, 10 dB 

P-CCPCH ON, 12 dB 
P-SCH & S-SCH Power=–12 dB 

PICH ON, 15 dB, 2 
DPCH ON, 13 dB, 8, RMC12.2 kbps 
OCNS ON, 6 Codes (ch=122-127) 

HS-SCCH1 ON, 13 dB, 9, Coded 
HS-SCCH2 OFF, 40 dB, 0, Coded 

HS-PDSCH2 40 dB, HS-DSCH 
HS-SCCH3 OFF, 40 dB, 0, Coded 

HS-PDSCH3 40 dB, HS-DSCH 
HS-SCCH4 OFF, 40 dB, 0, Coded 

HS-PDSCH4 40 dB, HS-DSCH 
SFN Cycle 4096 

TrCH1 Data PN9fix 
TrCH2 Data 16bitRepeat 

TFCI 0 
Channelization Code 

Offset 
2 

RV Information 0 
UE Identity 0 

CRC Error Insertion Correct 
Payload Data PN9fix 

HARQ Process Cycle 6 
TTI Start Offset 0 

Process Setting File Non 
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Table 3.1.1-5  Parameters specific to each FRC H-Set (H-Set1 and H-Set2) 

Parameter 
H-Set1 H-Set2 

QPSK 16QAM QPSK 16QAM 

HS-PDSCH1 
ON, 12.99 

dB,  
HS-DSCH 

ON, 12.02 
dB,  

HS-DSCH 

ON, 12.99 
dB,  

HS-DSCH 

ON, 12.02 
dB,  

HS-DSCH 
Number of Physical 

Channel Code 5 4 5 4 

Modulation QPSK 16QAM QPSK 16QAM 
Transport Block 
Size Information 41 36 41 36 

Virtual IR Buffer Size 9600 
Number of HARQ 

Processes 2 3 

Inter-TTI Distance 3 2 

 
Table 3.1.1-6  Parameters specific to each FRC H-Set (H-Set3 through H-Set5) 

Parameter 
H-Set3 H-Set4 H-Set5 

QPSK 16QAM QPSK QPSK 

HS-PDSCH1 
ON, 12.99 

dB,  
HS-DSCH 

ON, 12.02 
dB,  

HS-DSCH 

ON, 12.99 
dB,  

HS-DSCH 

ON, 12.99 
dB,  

HS-DSCH 
Number of Physical 

Channel Code 5 4 5 5 

Modulation QPSK 16QAM QPSK QPSK 
Transport Block 
Size Information 41 36 41 41 

Virtual IR Buffer Size 9600 7200 9600 
Number of HARQ 

Processes 6 2 3 

Inter-TTI Distance 1 2 1 
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 W-CDMA 

 

Figure 3.1.1-5  W-CDMA menu 

 

 Selects the bit rate setting for Reference Measurement Channels 
(RMC) specified in 3GPP TS25.101, TS25.104. 
RMC 12.2kbps (for RX test) 
RMC 12.2kbps (for Performance test) 
RMC 64kbps (for Performance test) 
RMC 144kbps (for Performance test) 
RMC 384kbps (for Performance test) 
 

Table 3.1.1-7  Physical channel powers for RMC 12.2kbps (for RX test) 

Physical 
Channel 

Power ratio 

CPICH CPICH_Ec/DPCH_Ec = –3.32 dB 
P-CCPCH P-CCPCH_Ec/DPCH_Ec = –5.32 dB 

P-SCH & S-SCH SCH_Ec/DPCH_Ec = –5.32 dB 
PICH PICH_Ec/DPCH_Ec = –8.32 dB 
DPCH DPCH_Ec/Ior = 10.32 dB 

 
Table 3.1.1-8  Physical channel powers for channels other than  

RMC 12.2kbps (for RX test) 

Physical 
Channel 

Power ratio 

CPICH CPICH_Ec/Ior = 10 dB 
P-CCPCH P-CCPCH_Ec/Ior = 12 dB 

SCH SCH_Ec/Ior = 12 dB 
PICH PICH_Ec/Ior = 15 dB 

DPC
H 

12.2 
kbps DPCH_Ec/Ior = 16.6 dB 

64 kbps DPCH_Ec/Ior = 12.8 dB 
144 
kbps DPCH_Ec/Ior = 9.8 dB 

384 
kbps DPCH_Ec/Ior = 5.5 dB 

OCNS The power where the total of all the channels 
including OCNS is 0 dB. 
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■ Transfer Setting menu 

The Transfer Setting menu contains the following item. 
 

 

Figure 3.1.1-6  Transfer Setting menu 

 

 Transfer & Setting Wizard  
Note: 

This function is available only when MG3700 or MG3710 is 
selected in the Select instrument screen.  

Displays the Transfer Setting Wizard screen. Every operation 
ranging from connecting the PC and MG3700A or MG3710A and 
transferring the waveform pattern to the MG3700A or MG3710A, 
to loading the waveform pattern into the MG3700A or MG3710A 
ARB memory is performed at this screen. 
 

■ Tool buttons 

Notes: 

 Transfer&Setting Wizard is available only when MG3700 or 
MG3710 is selected in the Select instrument screen.  

 Calculation & Load and Calculation & Play are available 
only when this software is used on MG3710A. 

 

 Recall Parameter File 

  Save Parameter File 

  Calculate Waveform Pattern 

  Calculation & Load 

  Calculation & Play 

 Transfer & Setting Wizard 

  Exit 

 
Clicking a tool button operates the same as the corresponding 
commands in the menu.  
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■ Total Power display 

 

Figure 3.1.1-7  Total Power display 

 

 The total power of the channels that are set to ON (excluding OCNS) 
is displayed in this field. If the total power displayed here is out of 

0.01 dB when OCNS is OFF, the warning message shown in Figure 
3.1.1-7 is displayed during total power calculation, prompting to 
normalize the total power. 

 

Figure 3.1.1-8  Warning message 

 

 Since the total power value displayed here is calculated from the total 
power of all the channels that are set to ON, if a channel that includes 
DTX (Discontinuous Transmission) is used, the average power within 
the time when all the channels are output becomes 0 dB. When a 
channel that includes DTX is used, therefore, the average power value 
obtained by measuring the RF output level with a power meter does 
not match the setting level of the mainframe. 
 

■ Normalize Power button 

 

Figure 3.1.1-9  Normalize Power button 

 

 This button is enabled when OCNS is OFF. When this button is 
clicked, the value displayed in Total Power is subtracted from the 
power of each channel that is set to ON. As a result, the total power is 
normalized to 0 dB while retaining the power ratio between channels. 
 

■ Status display 

 The status display on the bottom of the screen displays operation 
statuses such as a warning occurred during setting. 
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3.1.2 Details of setting parameters on main screen 
This section describes the details of the setting items on the Downlink 
main screen. 

Setting Item Scrambling Code 
Functional Outline Sets the downlink scrambling code number. 
Setting Parameters Setting Range 

Scrambling Code 0 to 8191 
Details The scrambling code set here is applied to the scramble of all the channels 

including CPICH, P-CCPCH, and PICH. Therefore, the primary scrambling 
code number should be set normally for this setting. 
The primary scrambling code number is expressed as follows: 
Primary scrambling code number = 16*i (i = 0 to 511) 

 

Setting Item Number of Frames 

Functional Outline Sets the number of frames to be generated.  

Setting Parameters Setting Range 

Number of 
Frames 

1 to the maximum number of frames for the waveform 
memory 

Auto Check box selected or cleared.  

Details Refer to Appendix B for the maximum number of frames for the waveform 
memory 
When Auto is selected, it automatically calculates the necessary number of 
frames for waveform generation, and generates the waveform pattern 
accordingly.  

 

Setting Item CPICH 
Functional Outline Performs settings related to CPICH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 [dB], setting resolution: 0.01 dB 

Details The channelization code of the CPICH is fixed to 0. 

 

Setting Item P-CCPCH 
Functional Outline Performs settings related to P-CCPCH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 [dB], setting resolution: 0.01 dB 
P-SCH & S-SCH Power 40.00 to 0.00 [dB], setting resolution: 0.01 dB 

Details The channelization code of the P-CCPCH is fixed to 1. 
BCH is mapped for P-CCPCH. 
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Setting Item PICH 
Functional Outline Performs settings related to PICH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 [dB], setting resolution: 0.01 dB 
Channelization Code 0 to 255 
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Setting Item DPCH 
Functional Outline Performs settings related to Downlink DPCH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 [dB], setting resolution: 0.01 dB 
Channelization Code 0 to SF  1 

SF (spreading factor) varies depending on the 
setting of Data as follows: 
RMC 12.2 kbps = 128 
RMC 64 kbps = 32 
RMC 144 kbps = 16 
RMC 384 kbps = 8 
AMR1/AMR2/AMR3 = 128 
ISDN = 32 
384 kbps Packet = 8 
User Edit TrCH = Spreading Factor set in the 
Channel Edit screen 

Data RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/ 
RMC 384 kbps/AMR1/AMR2/AMR3/ISDN/ 
384 kbps Packet/User Edit TrCH 

Details Each channel coding parameter of the DCH is set according to the standard 
format selected by Data. 
RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/RMC 384 kbps 

Refer to 3GPP TS25.101 Annex A.3 DL reference measurement channel for 
details of these channels. See the next and subsequent pages for details of 
each parameter. 
AMR1/AMR2/AMR3/ISDN 

Refer to 3GPP TR25.944 4.1.1.3 Example for DCH for details of these 
channels. See the sections below for details of DTCH, DCCH, and 
Multiplexing. 
DTCH 

AMR1: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #1) 
AMR2: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #2) 
AMR3: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #3) 
ISDN: 4.1.1.3.1.6 Example for 64 kbps data 
DCCH 

AMR1/AMR2/AMR3/ISDN: 4.1.1.3.1.1 Example for 3.4 kbps data 
Multiplexing 

AMR1/AMR2/AMR3: 4.1.1.3.2.2 Example for multiplexing of 12.2 kbps 
   data and 3.4 kbps data 
ISDN: 4.1.1.3.2.5 Example for multiplexing of 64 kbps data and 3.4 kbps data
 
User Edit TrCH 

When User Edit TrCH is selected, the settings of parameters for TrCH can be 
changed on the Channel Edit screen that is opened by clicking the Channel 
Edit button. Select User Edit TrCH when setting a channel other than the 
standard transport channels described above. 
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 DL_RMC_12_2 kbps channel coding parameters 

Table 3.1.2-1  DL reference measurement channel 12.2 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 12.2 
DPCH ksps 30 

Slot Format #i  11 
TFCI  On 

Power offsets PO1, PO2 and PO3 dB 0 
Puncturing % 14.7 

 
Table 3.1.2-2  DL reference measurement channel 12.2 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 244 100 

Transport Block Set Size 244 100 
Transmission Time Interval 20 ms 40 ms 

Type of Error Protection Convolution Coding Convolution Coding 
Coding Rate 1/3 1/3 

Rate Matching attribute 256 256 
Size of CRC 16 12 
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Figure 3.1.2-1  Channel coding for DL reference measurement channel 12.2 kbps 
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 DL_RMC_64 kbps channel coding parameters 

Table 3.1.2-3  DL reference measurement channel 64 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 64 
DPCH ksps 120 

Slot Format #i  13 
TFCI  On 

Power offsets PO1, PO2 and PO3 dB 0 
Repetition % 2.9 

 
Table 3.1.2-4  DL reference measurement channel 64 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 1280 100 

Transport Block Set Size 1280 100 
Transmission Time Interval 20 ms 40 ms 

Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 

Rate Matching attribute 256 256 
Size of CRC 16 12 

Position of TrCH in radio frame fixed fixed 
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Figure 3.1.2-2  Channel coding for DL reference measurement channel 64 kbps 
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 DL_RMC_144 kbps channel coding parameters 

Table 3.1.2-5  DL reference measurement channel 144 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 144 
DPCH ksps 240 

Slot Format #i  14 
TFCI  On 

Power offsets PO1, PO2 and PO3 dB 0 
Puncturing % 2.7 

 
Table 3.1.2-6  DL reference measurement channel 144 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 2280 100 
Transport Block Set Size 2280 100 
Transmission Time Interval 20 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 
Size of CRC 16 12 
Position of TrCH in radio frame fixed fixed 
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Figure 3.1.2-3  Channel coding for DL reference measurement channel 144 kbps 
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 DL_RMC_384 kbps channel coding parameters 

Table 3.1.2-7  DL reference measurement channel 384 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 384 
DPCH ksps 480 

Slot Format #i  15 
TFCI  On 

Power offsets PO1, PO2 and PO3 dB 0 
Puncturing % 22 

 
Table 3.1.2-8  DL reference measurement channel 384 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 3840 100 

Transport Block Set Size 3840 100 
Transmission Time Interval 10 ms 40 ms 

Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 

Rate Matching attribute 256 256 
Size of CRC 16 12 

Position of TrCH in radio frame fixed fixed 
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Figure 3.1.2-4  Channel coding for DL reference measurement channel 384 kbps 
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Setting Item OCNS 
Functional Outline Sets OCNS ON/OFF. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Type 16 Codes/6 Codes(ch=122-127)/6 Codes(ch=2-7) 

Details When OCNS is set to ON, the power of OCNS (Orthogonal Channel Noise 
Simulator) is adjusted so that the total power of all the channels that are set 
to ON becomes 0 dB. 
Since the OCNS power is calculated from the total power of all the channels 
that are set to ON, if a channel that includes DTX (Discontinuous 
Transmission) is used, the average power within the time when all the 
channels are output becomes 0 dB. When a channel that includes DTX is 
used, therefore, the average power value obtained by measuring the RF 
output level with a power meter does not match the setting level of the 
MS2690A/MS2691A/MS2692A or MS2830A. 

When the total power of all the channels that are set to ON (excluding 
OCNS) exceeds 0 dB while OCNS is set to ON, an error occurs and data 
generation is cancelled. The total power of all the channels that are set to ON 
(excluding OCNS) is displayed in Total Power on the screen. 

To clear this error, set OCNS to OFF or attenuate the power of each channel. 
For example, when P-CCPCH, CPICH, and DPCH are set as follows, the 
total power of the channels except OCNS exceeds 0 dB. OCNS cannot be set 
to ON in this event, and it is regarded as an error. 
An error may occur when the actual total power exceeds 0 dB at the 
thousandth or later places that are not displayed, even if 0.00 dB is displayed 
in Total Power on the screen. 

Total > 0.0 dB 

P-CCPCH = 3.00 dB

CPICH = 3.00 dB

DPCH = 3.00 dB

OCNS = ?
 

When OCNS is set to OFF, click the Normalize Power button to adjust the 
power of each channel so that the total power of all the channels becomes 0 
dB while retaining the power ratio between channels. 

P-CCPCH = 3.00 dB 

CPICH = 3.00 dB 

Normalize

DPCH = 3.00 dB 

P-CCPCH = 4.80 dB

CPICH = 4.80 dB 

DPCH = 4.80 dB  
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Details (Cont’d) OCNS consists of 6-channel (for HSDPA) or 16-channel (for Performance 
requirement) DPCH. The tables below show the parameters. Refer to 3GPP 
TS25.101 (Release 6) C5.2 “OCNS Definition” Tables C.6 and C.12 for details. 

OCNS (6 channels, ch2 to 7) 

Channelization 
Code at SF = 128

Relative Level 
Setting (dB) 

2 0 

3 2 

4 2 

5 4 

6 1 

7 3 
 

 

OCNS (6 channels, ch122 to 127, TS25.101 V5.12.0 or later) 

Channelization 
Code at SF = 128

Relative Level 
Setting (dB) 

122 0 

123 2 

124 2 

125 4 

126 1 

127 3 
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Details (Cont’d)  

OCNS (16 channels) 

Channelization 
Code at SF = 128

Relative Level 
Setting (dB) 

2 1 

11 3 

17 3 

23 5 

31 2 

38 4 

47 8 

55 7 

62 4 

69 6 

78 5 

85 9 

94 10 

125 8 

113 6 

119 0 
 

 

[Displayed contents] 

An OCNS item Power displays the power of OCNS only. The total of this 
value and the value displayed in Total Power is always 0 dB. 
The Channelization Code and SF (spreading factor) used by OCNS are also 
displayed. 
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Setting Item HS-SCCH1, HS-SCCH2, HS-SCCH3, HS-SCCH4 
Functional Outline Sets the physical parameters of HS-SCCH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 [dB], setting resolution: 0.01 dB 
Channelization Code 0 to 127 
Data PN9/PN9fix/PN15fix/16bitRepeat/Coded 

Details ON/OFF 

Toggles the HSDPA channel ON/OFF. This setting is commonly applied to 
HS-PDSCH1 to 4 that correspond to HS-SCCH1 to 4, respectively. When 
HS-SCCH1 is set to OFF, for example, HS-PDSCH1 is also set to OFF. 

Data 

This setting indicates the type of data sequence to be inserted to the 
subframes of HS-SCCH1 to 4. PN9fix and PN15fix are PN9/PN15 data reset 
by each subframe. PN data is not continuous between subframes. 
Select Coded when transmitting control data related to HSDPA on the 
HS-SCCH. 

 

Setting Item HS-PDSCH1, HS-PDSCH2, HS-PDSCH3, HS-PDSCH4 
Functional Outline Sets the physical parameters of HS-PDSCH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 [dB], setting resolution: 0.01 dB 
Channelization Code Displays Channelization Code.  
Data PN9/PN9fix/PN15fix/16bitRepeat/HS-DSCH 

Details ON/OFF 

Toggles the HSDPA channel ON/OFF. This setting is commonly applied to 
HS-SCCH1 to 4 that correspond to HS-PDSCH1 to 4, respectively. When 
HS-PDSCH1 is set to OFF, for example, HS-SCCH1 is also set to OFF. 

Data 

This setting indicates the type of data sequence to be inserted to the 
subframes of HS-PDSCH1 to 4. PN9fix and PN15fix are PN9/PN15 data reset 
by each subframe. PN data is not continuous between subframes. 
Select HS-DSCH when mapping the data sequence that was channel-coded 
according to 3GPP TS25.212 (Release 6) to HS-PDSCH. 
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3.1.3 Details of setting parameters on Channel Edit screen 
When the Channel Edit button is clicked, the Channel Edit screen shown 
below is displayed. This section describes the details of the setting items 
on this screen. 

 

Figure 3.1.3-1  Channel Edit screen 

 

 OK and Cancel buttons  
The OK and Cancel buttons are provided to close the Channel Edit 
screen after performing setting. 
 

 When the OK button is clicked: 
The Channel Edit screen is closed, applying the settings. 

 When the Cancel button is clicked: 
The Channel Edit screen is closed, ignoring the settings. 
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Setting Item P-CCPCH Edit 
Functional Outline Performs settings for P-CCPCH. 
Setting Parameters Setting Range 

SFN Cycle Short or 4096 
Details This is the cycle of SFN (System Frame Number) that is transmitted by BCH 

mapped to P-CCPCH.  

When set to Short, the cycle of SFN becomes a common multiple of the 
maximum TTI cycle. This will shorten the calculation time and lessen the 
data volume and number of frames to be generated. If the normal cycle of 
4096 is required, set to 4096.  
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Setting Item DPCH Edit (PhyCH) 
Functional Outline Performs settings for DL-DPCH physical channels. 
Setting Parameters Setting Range 

DPCH Data PN9/PN9fix/PN15fix/16 bitRepeat/TrCH 
TFCI 0 to 1023 
Spreading Factor 4, 8, 16, 32, 64, 128, 256, 512 
BER 0.0 to 100.0%, setting resolution: 0.1% 
Slot Format #0 to #16 
Timing Offset 0 to 149 
TPC Edit 0000 0000 0000 0000 0000 0000 0000 0000 0000 

0000 0000 0000 0000 0000 0000 to 
1111 1111 1111 1111 1111 1111 1111 1111 1111 
1111 1111 1111 1111 1111 1111 

Details DPCH Data 
Selects the data to be inserted to DPCH of the physical channel. 
PN9fix/PN15fix is PN9/PN15 data reset by each frame. PN data is not 
continuous between frames. When performing operations such as BER (Bit 
Error Rate) measurement for a reception sensitive test, select PN9 with 
which PN data is continuous between frames. When [PN9fix, PN15fix, or PN9 
is selected, a physical frame structure is not configured since PN data is 
mapped to all areas of DPDCH and DPCCH in this event. 
PN9 can be set only when all four HSDPA channels are set to OFF. 
When TrCH is selected, a physical frame structure is configured for DPDCH 
and DPCCH, and the data for which DCH frame coding is executed is 
inserted to DPDCH. 

Slot Format, TPC Edit 
These can be set only when DPCH Data is set to TrCH. 

BER 
Sets the error rate to be inserted to the transmission data. 
This setting is valid when DPCH Data is set to PN9. 
When DPCH Data is set to PN9, an error is randomly inserted to the PN9 
data that is inserted directly to a physical frame. 

Timing Offset 
Sets an offset for the DPCH frame timing for P-CCPCH with a value of 256 
chip multiplied by n. 

TPC Edit 
Sets the data to be inserted to the TPC bit in a 4-frame cycle. Each bit 
indicates the symbol (0/1) of the TPC bit to be assigned to each slot. Data is 
assigned to each slot sequentially from the left. 
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Setting Item DPCH Edit (TrCh Edit) 
Functional Outline Performs settings for TrCH. 
Setting Parameters Setting Range 

TrCH Number 1 to 8 
DTX Fix/Flex 
Data PN9/PN9fix/PN15fix/16 bit Repeat/User File 
TTI 10, 20, 40, 80 ms 
Max. TrBk Size 0 to 5000 
TrBk Size 0 to 5000 
Max. TrBk Set No. 0 to 64 
TrBk Set No. 0 to 64 
CRC 0, 8, 12, 16, 24 bits 
Coder CC1/2, CC1/3, TC 
RM attribute 1 to 256 
BER 0.0 to 100.0%, setting resolution: 0.1% 
BLER 0 to 100%, setting resolution: 1% 

Details TrCH Number 
Sets the number of TrCH (transport channels). The number of TrCh that can 
be edited varies depending on this setting. 

Data 
Selects the data to be inserted to Information Data of the transport channel. 
PN9fix/PN15fix is PN9/PN15 data reset at the last data of a signal. The last 
data of a signal and the first data of the next signal are not continuous. 
PN9 can be set only when all four HSDPA channels are set to OFF. 

Max. TrBk Size, Max. TrBk Set No. 
Sets the maximum TrBk Size and the number of TrBk Sets in TFCS. 

Coder 
Selects the channel coding type. CC1/2 and CC1/3 indicate a convolutional 
code at coding rates of 1/2 and 1/3 respectively. TC indicates a turbo code. 

BER 
This setting is valid when Data is set to PN9. The bits in the information 
data to be inserted to the transport channel are randomly inverted according 
to the specified error rate. 

BLER 
This setting is valid when Data is set to PN9. Half of the bits in the CRC to 
be added to each transport block are inverted randomly according to the 
specified error rate. 
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3.1.4 Details of setting parameters on HSDPA Edit screen 
When the Edit button is clicked, the HSDPA Edit (Ch1 to Ch4) screen 
shown below is displayed. This section describes the details of the setting 
items on this screen. 

 

Figure 3.1.4-1  HSDPA Edit screen 

 

 OK and Cancel buttons 
The OK and Cancel buttons are provided to close the HSDPA Edit 
screen after performing setting. 
 

 When the OK button is clicked: 
The HSDPA Edit screen is closed, applying the settings. 

 When the Cancel button is clicked: 
The HSDPA Edit screen is closed, ignoring the settings. 
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Setting Item HSDPA transport channel parameter 
Functional Outline Sets the parameters for HS-SCCH and HS-PDSCH. 
Setting Parameters Setting Range 

Channelization Code 
Offset 

1 to (16  Number of Physical Channel Code) 

Number of Physical 
Channel Code 

1 to (16  Channelization Code Offset) 

Modulation QPSK or 16QAM 
Transport Block Size 
Information 

0 to 63 

RV Information 0 to 7 
UE Identity 0 to 65535 
CRC Error Insertion Correct or Fail 
Number of HARQ 
Processes 

0 to 8 

Virtual IR Buffer Size 800 to 304000 
Payload Data PN9/PN9fix/PN15fix/16 bitRepeat 

Details [Channelization Code Offset, Number of Physical Channel Code, Modulation, 
Transport Block Size Information, RV Information, UE Identity] 
When Coded is set for Data of HS-SCCH or HS-DSCH is set for Data of 
HS-PDSCH on the main screen, the data for which channel coding is 
performed according to these settings is assigned to HS-SCCH or 
HS-PDSCH. 

[Channelization Code Offset, Number of Physical Channel Code] 
These settings are transmitted on HS-SCCH as “channelization code 
set-bits.” 
Code Offset indicates the start number of each channelization code of 
HS-PDSCH. 
Number of Physical Channel Code indicates the number of HS-PDSCH 
codes. 
These settings have an effect on their setting range each other, as described 
above. 

[CRC Error Insertion] 
Because the CRC bits of all the transport blocks are inverted when Fail is 
selected, an error occurs for a CRC check at reception. 

[Number of HARQ Processes] 
Indicates the number of HARQ processes. 
Refer to the description of the “Transmitting Pattern Edit” setting item for 
details. 

[Payload Data] 
Selects the data to be used for HS-DSCH. 
PN9fix/PN15fix is PN9/PN15 data reset by each HARQ process. PN data is 
not continuous between HARQ processes. When any HSDPA channel is set to 
ON, PN9 cannot be selected for DTCH Information Data. If any HSDPA 
channel is changed to ON while PN9 is set for DTCH Information Data, DTCH 
Information Data is changed to PN9fix. 
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Setting Item Transmitting Pattern Edit 
Functional Outline Sets the HARQ process output pattern. 
Setting Parameters Setting Range 

HARQ Process Cycle 1 to 16 (1 to 6 when PN9 is set for Payload Data) 
Inter-TTI Distance 1 to 8 
TTI Start Offset 0 to 7 
Process Setting File Use or Not use 

Details [HARQ Process Cycle] 
Sets the repetition cycle of the HARQ Process set by Number of HARQ 
Processes in the subframe (2 ms) units. 

[Inter-TTI Distance] 
Sets the interval between HARQ Processes by in the subframe (2 ms) units. 
Note, however, that the TTI between the HARQ process cycles does not 
match this setting value if Inter-TTI Distance  Number of HARQ Processes 
does not equal to the value of HARQ Process Cycle. 

[TTI Start Offset] 
The HARQ process start timing is delayed by this setting in subframe units. 
When two or more HSDPA channels are set to ON and their HARQ Process 
Cycles are same, the output timing of each HSDPA channel can be delayed 
by using this setting. 

[Process Setting File] 
When this check box is selected, the “Open file” screen is displayed to select a 
process setting file to be read for setting the transmission pattern of 
HS-SCCH and/or HS-PDSCH. The HARQ Process is set based on the settings 
in the process setting file selected in this screen. 
When the process setting file is selected, the settings of HARQ Process 
Cycle, Inter-TTI Distance, and TTI Start Offset are invalid. 

A process setting file should a text file with the extension “.txt,” and should 
be created in the format as shown below: 

#MX269901A HSDPA IQproducer Process Setting File 
Process Cycle = 6 frame 
01020 
30405 
06070 
80102 
   : 
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Details (Cont’d) There are the following restrictions on process setting files: 
(1) Process cycle: 1 to 512 frames 
(2) HARQ process number: 0, 1, 2, …, 8 (0 indicates DTX.) 
(3) Although each line is fed by 5 characters (5 subframes = 1 frame) in the 

example above, commas (,), periods (.), spaces, and line feed characters 
are ignored. 

(4) If Payload Data = PN9 and Process Cycle  7, the data length is greater 
than the waveform memory capacity of the mainframe, resulting in an 
error. Set Payload Data to other than PN9.  

(5) When the same process number appears, it is regarded as a new HARQ 
process and the NDI (New Data Indicator) bit in HS-SCCH is 
automatically changed from 0 to 1 or from 1 to 0. The NDI bit is set to 0 
at the beginning of the waveform pattern in all HARQ process cycles. 
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Figure 3.1.4-2  HARQ Process Cycle 
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3.1.5 Calculation screen  
Clicking Calculation & Load, Calculation & Play, or the OK button on 
the Export File name Input screen box will start the waveform 
generation.  

The Calculation screen is displayed while a waveform pattern is being 
generated. On this screen, the progress bar is displayed indicating the 
generation process of the waveform pattern and the progress of the 
waveform pattern generation. The generation of the waveform pattern 
can be stopped by clicking the Cancel button. When cancelled, it returns 
to the main screen.  

 

Progress report

Progress bar

Cancel button
 

Figure 3.1.5-1  Calculation Screen (In Progress) 

 

After waveform pattern generation is finished, the message “Calculation 
Completed.” is displayed in the progress window and the Cancel button 
changes to the OK button.  

When the generation is complete, you can return to the setting screen by 
clicking the OK button. After waveform generation, two files with .wvi 
and .wvd extension are output. 

 

 

Figure 3.1.5-2  Calculation Screen (Completed) 

 

Note: 

When using this software on MG3710A, and selecting Calculation 
& Load or Calculation & Play, the waveform generation ends 
without displaying the above screen.  
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3.1.6 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation.  

Button for selecting load destination 

 

 

Figure 3.1.6-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen. 

 

Figure 3.1.6-2  Select Memory Screen 

 

After selecting the load destination of generated waveform in the Select 
Memory screen and clicking the OK button, the Load Setting screen will 
be shown again. Click the OK button in the Load Setting screen, and 
then the loading of waveform starts.  

Notes: 

● To exit this screen without loading the waveform pattern, click 
the Cancel button in the Load Setting screen.  



 

Chapter 3  Detailed Description of Functions 

3-38 

● If the configuration of generated waveform pattern used two 
memories, the Select SG screen displays just like Calculation & 
Play. 

 

3.1.7 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A. 

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 3.1.7-1  Select SG Screen 

 

3.1.8 Saving/reading parameters 
This numeric values and settings for each item can be saved in a 
parameter file by using this software. 

 Saving parameter file 

When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A  

1. Select Save Parameter File from the File menu or click the   
tool button to display the parameter file saving screen shown below. 

2. Enter a file name in the File name text box and click the Save 
button to save the parameter file. 
When the save destination is not changed in the Save in box, the 
parameter file is saved in the following directory with the entered 
file name: 
X:\IQproducer\HSDPA\Entered file name.prm 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 
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Figure 3.1.8-1  Parameter file saving screen 

 

When running on MG3710A 

(1) Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen.  

 

Figure 3.1.8-2  Parameter file saving screen (MG3710A) 

 

(2) Select the directory where the files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK. To initialize the setting in the Directories field, click the Default 
Root button. 
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 Reading parameter file 

When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A  

1. Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen shown. 

2. Select a parameter file to be read from the file list, and then click 
the Open button to read the selected parameter file. 
 

 

 

Figure 3.1.8-3  Parameter file reading screen 

 

When running on MG3710A 

(1) When User File is selected for Data Type setting in the Channel 
Setting screen, the user file reading screen is displayed.  

 

Figure 3.1.8-4  Parameter file reading screen (MG3710A) 

 

(2) Select the directory where the user files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK. To initialize the setting in the Directories field, click the Default 
Root button.  
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3.1.9 Generating waveform pattern file 
A waveform pattern file to be used in the mainframe can be generated 
based on the setting values. In the screen shown in Figure 3.1.9-2, the 
waveform pattern name and comments can be entered and whether to 
enable or disable the RRC filter can be set. 
The number of frames to be generated varies depending on the setting 
conditions for each channel, and the time required for generating a 
waveform pattern also varies accordingly. 

<Procedure> 

1. Select Calculate Waveform Pattern from the Edit menu or click the 

  tool button. 
 

At this time, the Warning message shown below appears when OCNS 
is set to OFF and the value of Total Power is out of 0.01 dB. 

 

Figure 3.1.9-1  Warning message 

 

Click the OK button to normalize the Total Power and proceed with the 
next step.  
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2. The file name input screen is displayed. 

 
File name display area

Output destination folder
selection button

Package name input box

Output file name input box

Comment input box

RRC Filter Off checkbox

 

Figure 3.1.9-2  File name input screen 

 

 Enter a package name in the package name input box, up to 31 
characters. 
Enter a file name in the file name input box, up to 18 characters. 
1-byte alphanumeric characters and the following symbols can be 
used for a file name: 
! % & ( ) + = ` { } _ - ^ @ [ ] 

 When a file name is entered, the file to be generated is displayed in 
the file name display area in the following format: 

File name format: 

 test_A.wvi 

Extension: wvi… Information file (text format) 

wvd… Data f ile (binary format) 

Memory to read： A…Memory A 

 B…Memory B 

Entered file name  

 Enter a comment for the waveform pattern in a comment input box. 
Three comment input boxes are provided, and a comment can be 
entered in each line within 38 characters. 
1-byte alphanumeric characters and symbols can be used for 
comments. 
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The contents of each comment are displayed on the screen when the 
corresponding waveform pattern is selected by the Vector Signal 
Generator. Leave the comment boxes blank if not necessary. 
When the RRC Filter Off check box is selected, symbol data that 
does not pass through the RRC filter is generated as a waveform 
pattern. This check box needs not be selected under normal 
conditions. 

 

3. Click OK on the Export File screen. The Calculation screen shown in 
Figure 3.1.5-1 is displayed and waveform pattern generation starts 
(the output destination folder, package name, and file name must be 
set to start waveform pattern generation). 

 

When started with MS269x or MS2830A and when MS269x or 
MS2830 is selected in the in the Select instrument screen, waveform 
pattern files generated by this application are saved in the following 
directory:  

Installed OS Export destination folder 

Windows Embedded 
Standard 7 

C:\Anitsu\Signal Analyzer\ 
System\Waveform 

Other than above C:\Program Files\Anritsu Corporation\ 
Signal Analyzer\System\Waveform 

 

When used with MG3710A, the files are saved in the following 
directory: 

C:\Anritsu\MG3710A\User Data\Waveform 

 

In other cases, clicking the output destination selection button 
displays the Browse for Folder screen shown in Figure 3.1.9-3. The 
output destination folder can be selected from this screen. 
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Figure 3.1.9-3  Browse for Folder screen 

 
If no destination folder is selected, the file is generated in the 
following folder.  
X:\IQproducer\HSDPA\Data 
(Where “X:\IQproducer” is the folder you installed IQproducerTM). 

 

Note: 

The HSDPA/HSUPA Uplink IQproducer waveform pattern file 
generation and the HSDPA/HSUPA Downlink IQproducer 
waveform pattern file generation must be operated exclusively. 
An error dialog box will be displayed if the HSDPA/HSUPA 
Uplink IQproducer waveform pattern file generation is started 
while the HSDPA/HSUPA Downlink IQproducer waveform 
pattern file generation is operating, and vice versa. To start the 
HSDPA/HSUPA Uplink/Downlink IQproducer waveform pattern 
file generation while the other is operating, cancel the other file 
generation or wait until the other file generation is completed. 
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3.1.10 Auxiliary signal output 
When a waveform pattern generated by this software is selected by the 
mainframe, a marker signal synchronized with the RF signal is output 
from the AUX input/output connector of the rear panel as an auxiliary 
signal. TTI Pulse (Connector 1) is output.  
 

 TTI Pulse 
TTI cycle pulse synchronized with the symbol at the beginning of the 
frame is output from Connector 1. The signal polarity can be changed 
by changing the polarity of Marker 1. 
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3.2 Uplink Setup Screen 
3.2.1 Main screen 

On common platform screen, click the System (Cellular) tab, and then 
click HSDPA/HSUPA Uplink to display the main screen. 

 
Menu

Tool buttons

Normalize Power 
button 

 

Figure 3.2.1-1  Uplink main screen 
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■ File menu 
The File menu contains the following items. 

 

Figure 3.2.1-2  File menu 

 

 Select Option 
Notes: 

 This function is available only when MG3700, MG3710 or 
MS2830 is selected in the Select instrument screen. 

 ARB Memory Expansion (option) is not available for 
MS269xA. Only Memory 256M samples, 1 GB is available.  

 
■ When using MG3700A or MS2830A 

 Select whether the ARB memory expansion option 256Msamples is 
installed. Selecting With Option21 (Memory 512M samples)/With 
Option27 (Memory 256M samples) supports creation of larger 
waveform patterns. If the ARB memory expansion option is not 
installed, the generated waveform pattern may not be able to be 
used. Waveform patterns cannot be created with a size greater than 
256Msamples or 64M samples when Without Option21 (Memory 
512M samples)/Without Option27 (Memory 256M samples) is 
selected. Select either according to the presence of ARB memory 
expansion option. 

Table 3.2.1-1  Available Options for MG3700A or MS2830A 

Model Items 
ARB Memory 

Expansion 

MG3700A 

With Option21 (Memory 512M 
samples) 

1 GB x 2 
memory 

Without Option21 (Memory 
512M samples): 

512 MB × 2 
Memories 

MS2830A 

With Option27 (Memory 256M 
samples) 1 GB 

Without Option27 (Memory 
256M samples) 256 MB 

  



 

Chapter 3  Detailed Description of Functions 

3-48 

■ When using MG3710A 

 The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the Baseband 
Signal Combination Function (option) generates a bigger waveform 
pattern, while selecting the Baseband Signal Combination Function 
(option) generates a waveform pattern. If an uninstalled option is 
selected, sometimes the created waveform pattern may not be 
usable.  

 Set the combination of installed options based on the following 
setting items.  

Table 3.2.1-2  Available Options for MG3710A 

Items Combinations of Options 

Memory 64M samples None 

Memory 64M samples × 2 
Option48 
and 
Option 78 

Memory 256M samples 
Option45 
or 
Option 75 

Memory 256M samples × 2 
Option 45 and Option 48 
or 
Option 75 and Option 78 

Memory 1024M samples 
Option46 
or 
Option 76 

Memory 1024M samples × 2 
Option 46 and Option 48 
or 
Option 76 and Option 78 

 

The maximum size of the generated waveform pattern for each of 
the setting items is shown below.  

Table 3.2.1-3  Waveform Pattern Maximum Size 

Items Maximum Size 

Memory 64M samples 64M samples 
Memory 64M samples × 2 (With 
Option48, 78) 128M samples 

Memory 256M samples 256M samples 
Memory 256M samples × 2 (With 
Option48, 78) 512M samples 

Memory 1024M samples 512M samples 
Memory 1024M samples × 2 (With 
Option48, 78) 512M samples 
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 Recall Parameter File  
Sets the HSDPA/HSUPA Uplink parameters according to the 
setting of the parameter files saved by Save Parameter File. 
 

 Save Parameter File 
Saves the HSDPA/HSUPA Uplink setting parameters to a file. 
 

 Exit 
Exits the HSDPA/HSUPA Uplink IQproducerTM. 
 

■ Edit menu 

The Edit menu contains the following items. 

 

Figure 3.2.1-3  Screen when Edit is selected 

 

 Channel Edit 
Displays the Channel Edit screen in which the DPCH parameters 
are set. This is the same operation as that which occurs when Edit 
in the upper right part of the screen is clicked. 
 

 Channel Gain Setup 
Displays the Channel Gain Setup screen in which the power of each 
channel can be set using c, d, and other parameters. The setting 
of Power in the main screen is changed in accordance with the 
channel power set in this screen. 
 

 HSUPA Edit 
Displays the HSUPA Edit screen in which the HSUPA parameters 
are set. This is the same operation as that which occurs when Edit 
in the lower right part of the screen is clicked. 
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 Calculate Waveform Pattern 
Starts waveform pattern generation based on the settings on the 
screen. 
The number of frames to be generated varies depending on the 
setting conditions for each channel, and the time required for 
generating a waveform pattern also varies accordingly.  
The number of frames to be generated is displayed on the 
calculation progress screen. 
Refer to Appendix B “Number of Frames to Be Generated” for 
details on the number of frames to be generated in accordance with 
the Uplink setting conditions. 

 

 Calculation & Load  
Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded into the MG3710A waveform memory.  

 

 Calculation & Play  
Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform pattern is 
loaded and selected at the MG3710A waveform memory. 
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■ Transfer Setting menu 

The Transfer Setting menu contains the following items. 
 

 

Figure 3.2.1-4  Transfer Setting menu 

 

 Transfer Setting Wizard  
Note: 

This function is available only when MG3700 or MG3710 is 
selected in the Select instrument screen.  

Displays the Transfer Setting Wizard screen. Every operation ranging 
from connecting the PC and MG3700A or MG3710A and transferring 
the waveform pattern to the MG3700A or MG3710A, to loading the 
waveform pattern into the MG3700A or MG3710A ARB memory is 
performed at this screen. 

 
■ Tool buttons 

The following tool buttons are provided. 
Notes: 

 Transfer&Setting Wizard is available only when MG3700 or 
MG3710 is selected in the Select instrument screen.  

 Calculation & Load and Calculation & Play are available 
only when this software is used on MG3710A. 

 Recall Parameter File 

  Save Parameter File 

  Calculate Waveform Pattern 

  Calculation & Load 

  Calculation & Play 

 Transfer & Setting Wizard 

  Exit 

 
Clicking a tool button operates the same as the corresponding 
commands in the menu.  
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 Normalize Power button 

 

Figure 3.2.1-5  Normalize Power button 

 

 When this button is clicked, Total Power is subtracted from the power 
of each channel that is set to ON. As a result, the total power is 
normalized to 0 dB while retaining the power ratio of the channels 
that are set to ON. 
Since normalization is automatically executed if necessary at the start 
of waveform pattern generation, it is not always required to execute 
normalization manually by clicking the Normalize Power button. This 
button may be used for pre-check before waveform pattern generation. 
For normalization of HS-DPCCH, the greatest from among the ACK 
power, NACK power, and CQI power is used for calculation. Therefore, 
the average power value obtained by measuring the RF output level 
with a power meter does not match the setting level of the 
MS2690A/MS2691A/MS2692A or MS2830A unless the ACK_power, 
NACK_power, and CQI_power for HS-DPCCH are the same and do not 
include DTX (see Figure 3.2.1-6). 
For E-DPDCH(s), the power can be set for each E-DCH TTI, using an 
HARQ process setting file. Refer to the descriptions of E-DPCCH and 
E-DPDCH in Section 3.2. “Uplink Setup Screen” and see Figure 3.2.1- 
for details on the power of E-DPDCH(s) for each E-DCH TTI. 
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UL-DPCCH Power 

UL-DPDCH Power  

ACK 

Power CQI Power 

NACK 

Power

CQI Power 

E-DPCCH Power 

E-DPDCH(s) Power

0 dB

 

Figure 3.2.1-6  Channel powers and RF output level after normalization 

when HS-DPCCH level is variable 

 

  

UL-DPCCH Power 

UL-DPDCH Power  

ACK 

Power
CQI Power NACK 

Power
CQI Power 

0 dB 

E-DPCCH Power 

 

E-DPDCH(s) Power

 

Range where E-DPDCH(s) Power is set to 0 dB 
by HARQ Process Setting File 

 

Figure 3.2.1-7  Channel powers and RF output level after normalization 

when E-DPDCH(s) level is variable 
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3.2.2 Details of setting parameters on main screen 
 

Setting Item Scrambling Code 
Functional Outline Sets the scrambling code. 
Setting Parameters Setting Range 

0 to 16777215 

 

Setting Item Number of Frames 

Functional Outline Sets the number of frames to be generated.  

Setting Parameters Setting Range 

Number of 
Frames 

1 to the maximum number of frames for the waveform 
memory 

Auto Check box selected or cleared.  

Details Refer to Appendix B for the maximum number of frames for the waveform 
memory 
When Auto is selected, it automatically calculates the necessary number of 
frames for waveform generation, and generates the waveform pattern 
accordingly.  
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Setting Item UL-DPCCH, UL-DPDCH 
Functional Outline Performs settings for DPCCH and DPDCH. 
Setting Parameters Setting Range 

Channel ON/OFF ON or OFF 
Power 40.00 to 0 [dB], setting resolution: 0.01 dB 
Data RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/ 

RMC 384 kbps/AMR1/AMR2/AMR3/ISDN/ 
64 kbps Packet/User Edit TrCH 

Nmax-dpdch 0, 1 
Details RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/RMC 384 kbps 

Each channel coding parameter of the DCH is set according to the standard 
format selected by Data. 

Refer to 3GPP TS25.104 Annex A UL reference measurement channel for 
details of these channels. See the next and subsequent pages for details of 
each parameter. 

AMR1/AMR2/AMR3/ISDN 
Refer to 3GPP TR25.944 4.1.2.2 Example for DCH for details of these 
channels. See the sections below for details of DTCH, DCCH, and 
Multiplexing. 

DTCH 
AMR1: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #1) 
AMR2: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #2) 
AMR3: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #3) 
ISDN: 4.1.2.2.1.6 Example for 64 kbps data 
 
DCCH 
AMR1/AMR2/AMR3/ISDN: 4.1.2.2.1.1 Example for 3.4 kbps data 
 
Multiplexing 

AMR1/AMR2/AMR3: 4.1.2.2.2.2 Example for multiplexing of 12.2 kbps data 
and 3.4 kbps data 

ISDN: 4.1.2.2.2.5 Example for multiplexing of 64 kbps data and 3.4 kbps data
 
User Edit TrCH 
In this setting, the settings of parameters for TrCH can be changed on the 
Channel Edit screen that is opened by clicking the Edit button. Select User 
Edit TrCH when setting a channel other than the standard transport 
channels described above. 
 
Nmax-dpdch 
The maximum number of UL DPDCHs can be set, from 0 or 1 in this 
software. Ch Code of HS-DPCCH and Ch Code and IQ mapping of E-DPDCH 
depend on this setting. Refer to the descriptions of HS-DPCCH, E-DPCCH, 
and E-DPDCH in this section. 
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 UL_RMC_12_2 kbps channel coding parameters 

Table 3.2.2-1  UL reference measurement channel 12.2 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 12.2 
DPDCH kbps 60 
DPCCH kbps 15 

DPCCH Slot Format #I  0 
DPCCH/DPDCH power ratio dB 2.69 

TFCI  On 
Repetition % 22 

 
Table 3.2.2-2  UL reference measurement channel 12.2 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 244 100 

Transport Block Set Size 244 100 
Transmission Time Interval 20 ms 40 ms 

Type of Error Protection Convolution Coding Convolution Coding 
Coding Rate 1/3 1/3 

Rate Matching attribute 256 256 
Size of CRC 16 12 
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Figure 3.2.2-1  Channel coding for UL reference measurement channel 12.2 kbps 
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 UL_RMC_64 kbps channel coding parameters 

Table 3.2.2-3  UL reference measurement channel 64 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 64 
DPDCH kbps 240 
DPCCH kbps 15 

DPCCH Slot Format #I  0 
DPCCH/DPDCH power ratio dB 5.46 

TFCI  On 
Repetition % 19 

 
Table 3.2.2-4  UL reference measurement channel 64 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 2560 100 

Transport Block Set Size 2560 100 
Transmission Time Interval 40 ms 40 ms 

Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 

Rate Matching attribute 256 256 
Size of CRC 16 12 
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Figure 3.2.2-2  Channel coding for UL reference measurement channel 64 kbps 
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 UL_RMC_144 kbps channel coding parameters 

Table 3.2.2-5  UL reference measurement channel 144 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 144 
DPDCH kbps 480 
DPCCH kbps 15 

DPCCH Slot Format #I  0 
DPCCH/DPDCH power ratio dB 9.54 

TFCI  On 
Repetition % 8 

 
Table 3.2.2-6  UL reference measurement channel 144 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 2280 100 

Transport Block Set Size 5760 100 
Transmission Time Interval 40 ms 40 ms 

Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 

Rate Matching attribute 256 256 
Size of CRC 16 12 
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Figure 3.2.2-3  Channel coding for UL reference measurement channel 144 kbps 
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 UL_RMC_384 kbps channel coding parameters 

Table 3.2.2-7  UL reference measurement channel 384 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 384 
DPDCH kbps 960 
DPCCH kbps 15 

DPCCH Slot Format #I  0 
DPCCH/DPDCH power ratio dB 9.54 

TFCI  On 
Puncturing % 18 

 
Table 3.2.2-8  UL reference measurement channel 384 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 3840 100 

Transport Block Set Size 15360 100 
Transmission Time Interval 40 ms 40 ms 

Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 

Rate Matching attribute 256 256 
Size of CRC 16 12 
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Figure 3.2.2-4  Channel coding for UL reference measurement channel 384 kbps 
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Setting Item HS-DPCCH 
Functional Outline Performs settings for HS-DPCCH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Timing Offset 0 to 149 
ACK_Power 40.00 to 0 [dB], setting resolution: 0.01 dB 
NACK_Power 40.00 to 0 [dB], setting resolution: 0.01 dB 
CQI_Power 40.00 to 0 [dB], setting resolution: 0.01 dB 
ACK Pattern ACK_only, NACK_only, alt_ACK_NACK_DTX 
CQI value 0 to 30 
Pattern Setting File Use or Not use 

Details [Timing Offset] 

The output timing difference of HS-DPCCH from DPCCH is set with the 
setting resolution of 256 chips. When “1” is set, HS-DPCCH is output behind 
DPCCH by 256 chips. 

[ACK_Power, NACK_Power] 

The transmission power of the HARQ-ACK field for HS-DPCCH is set to the 
ACK_Power set value in ACK transmission, and set to the NACK_Power set 
value in NACK transmission. 

[CQI_Power] 

The transmission power of the CQI field for HS-DPCCH is set. 

Refer to the description of the Normalize Power button in this section for 
normalization executed when the Normalize Power button is pressed. 

[ACK Pattern] 

ACK_only, NACK_only, and alt_ACK_NACK_DTX indicate “transmitting 
ACK only,” “transmitting NACK only,” and “transmitting ACK, NACK, and 
DTX by rotation,” respectively. 
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Details (Cont’d) [Pattern Setting File] 
When this check box is selected, the “Open file” screen is displayed to select a 
text file with extension “.txt” to be read for setting the transmission pattern 
of HS-DPCCH.  
When Pattern Setting File is selected, the setting of ACK Pattern is invalid. 

The following shows a pattern setting file format example: 

#MX269901A HSDPA/HSUPA IQproducer HS-DPCCH Pattern Setting File 
Pattern Cycle = 6 frame 
A00N00D00D00D00 
A01A01A01A01A01 
N30N30N30N30N30 
D99D99D99D99D99 
A00N00D00D00D00 
A01A01A01A01A01 
   : 
 

Error judgment and error display are performed during file reading with the 
following conditions: 

(1) Pattern cycle: 1, 2, 3, …, 2048 frames 
Sets the period of the HS-DPCCH pattern in frame units. 

(2) For each HS-DPCCH pattern number (number other than the pattern 
cycle), one subframe is represented by a combination of three characters: 
, 0, and 1. 
: A (ACK), N (NACK), or D (DTX) 
01: CQI number 00, 01, 02, …, 30, 99 (“99” indicates DTX.) 

(3) Although each line is fed by 15 characters (1 frame) in the example 
above, commas (,), periods (.), spaces, and line feed characters are 
ignored. 
 

[Ch Code of HS-DPCCH] 
Ch Code of HS-DPCCH is set depending on the Nmax-dpdch value, as shown 
in the table below: 

Table  Ch Code of HS-DPCCH 

Nmax-dpdch Channelization code chs

0 C ch,256,33

1 C ch,256,64  
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Setting Item E-DPCCH, E-DPDCH 
Functional Outline Performs settings for E-DPCCH and E-DPDCH(s). 
Setting Parameters Setting Range 

Channel ON/OFF for 
E-DPCCH 

ON or OFF 

Channel ON/OFF for 
E-DPDCH(s) 

ON or OFF 

Power of E-DPCCH 40.00 to 0 [dB], setting resolution: 0.01 dB 
Power of E-DPDCH(s) 40.00 to 0 [dB], setting resolution: 0.01 dB 
E-DPDCH(SF2) Power/ 
E-DPDCH(SF4) Power 

10.00 to 10.0 [dB], setting resolution: 0.01 dB 

Details [Channel ON/OFF for E-DPCCH, Channel ON/OFF for E-DPDCH(s)] 

The channel On/Off can be set. If this parameter is set to Off, the 
corresponding channel becomes Off regardless of the set value (On/Off) 
described in the HARQ process setting file. 

[Power of E-DPCCH] 

The channel gain of E-DPCCH is set. 

[Power of E-DPDCH(s)] 

The channel gain of E-DPDCH(s) is set. If E-DPDCH(s) is a multi-code 
(2SF2, 2SF4, or 2SF2and 2SF4), the total power of E-DPDCH channels 
corresponds to the value set by this parameter. 
The channel gain of E-DPDCH(s) can be set for each E-DCH TTI by using an 
HARQ process setting file. In this event, E-DPDCHs are multiplexed by the 
power ratio shown below. 

(i) E-DCH TTI when E-DPDCH(s) Gain is set to 0 dB in the HARQ process 
setting file 
The E-DPDCHs are multiplexed by the power ratio set in Power of 
E-DPDCH(s) in the main screen. 

(ii) E-DCH TTI when E-DPDCH(s) Gain is set to a value other than 0 dB in 
HARQ process setting file 
The E-DPDCHs are multiplexed by the power ratio obtained by adding 
“Power of E-DPDCH(s) set in the main screen” and “Power of E-DPDCH(s) 
set in the HARQ process setting file.” 

[Ch Codes of E-DPDCH(s)] 

The channelization code of E-DPDCH is displayed. When HARQ Process 
Setting File is set in the HSUPA Edit screen, Ch Code of E-DPDCH is not 
displayed on the main screen. 

[Ch Code of E-DPCCH, Ch Code of E-DPDCH] 

The channelization code of each channel is displayed. The channelization 
codes can be set by editing E-DPDCH Channel Code in the HSUPA Edit 
screen (opened by clicking the Edit button on the main screen). When an 
HARQ process setting file is used, it can also be set by editing 
Channelization Codes of the HARQ process setting file. 
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Details (Cont’d) IQ mapping of E-DPDCH is set depending on the settings of HS-DSCH 
Configured and Nmax-dpdch, as shown in the table below. Note, however, 
that the same number of E-DPDCHs are mapped to IQ if the Ch Code of 
E-DPDCH is set to 2SF2, 2SF4, or 2SF2and2SF4. 

Table  IQ mapping of E-DPDCH  

(except the cases when Ch Code is 2SF2, 2SF4, or 2SF2and2SF4) 

Nmax-dpdch
HS-DSCH
configured

IQ mapping

0 No/Yes I
1 No Q
1 Yes I

 

E-DPCCH is mapped to the I phase. 
 

[E-DPDCH(SF2) Power/E-DPDCH(SF4) Power] 

The power ratio of SF2 E-DPDCH to SF4 E-DPDCH when 2SF2and2SF4 is 
selected is set. 
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3.2.3 Details of setting parameters on Channel Edit screen 
When the Edit button is clicked, the Channel Edit screen shown below is 
displayed. This section describes the details of the setting items on this 
screen. 

 

Figure 3.2.3-1  Channel Edit screen 

 

 When setting the User Edit TrCH in Data, it is possible to apply the 
transport channel settings of the standard pattern by pressing the 
Easy Setup button so as to facilitate an editing operation. 
 

 OK and Cancel buttons 
The OK and Cancel buttons are provided to close the Channel Edit 
screen after performing setting. 
 

 When the OK button is clicked: 
The Channel Edit screen is closed, applying the settings. 

 When the Cancel button is clicked: 
The Channel Edit screen is closed, ignoring the settings. 
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Setting Item DPCH Edit (PhyCH) 
Functional Outline Performs settings for UL-DPCH. 
Setting Parameters Setting Range 

UL-DPDCH Data PN9/PN9fix/PN15fix/16 bitRepeat/TrCH 
TFCI 0 to 1023 
UL-DPDCH  
Spreading Factor 

4, 8, 16, 32, 64, 128, 256 

BER 0.0 to 100.0%, setting resolution: 0.1% 
UL-DPDCH Slot 
Format 

#0 or #1 

Timing Offset 0 to 149 
TPC Edit 0000 0000 0000 0000 0000 0000 0000 0000 0000 

0000 0000 0000 0000 0000 0000 to 
1111 1111 1111 1111 1111 1111 1111 1111 1111 
1111 1111 1111 1111 1111 1111 

Details [UL-DPDCH Data] 
Selects the data to be inserted to UL-DPDCH of the physical channel. 
PN9fix/PN15fix is PN9/PN15 data reset by each frame. PN data is not 
continuous between frames. When performing operations such as BER (Bit 
Error Rate) measurement for a reception sensitive test, select PN9 with 
which PN data is continuous between frames. 
When TrCH is selected, a physical frame structure is configured for DPDCH 
and DPCCH and the data for which DCH frame coding is executed is 
inserted to DPDCH. 

[UL- DPDCH Slot Format, TPC Edit] 
These settings are enabled only when UL-DPDCH Data is set to TrCH. 

[BER] 
Sets the error rate to be inserted to the transmission data. 
This setting is valid when UL-DPDCH Data is set to PN9. 
When UL-DPDCH Data is set to [PN9], an error is randomly inserted to the 
PN9 data that is inserted directly to a physical frame.  

[Timing Offset] 
Sets an offset for the frame timing with a value of 256 chip multiplied by n. 

[TPC Edit] 
Sets the data to be inserted to the TPC bit in a 4-frame cycle. Each bit 
indicates the symbol (0/1) of the TPC bit to be assigned to each slot. Data is 
assigned to each slot sequentially from the left. 
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Setting Item DPCH Edit (TrCh) 
Functional Outline Performs settings for TrCH of UL-DPCH. 
Setting Parameters Setting Range 

TrCH Number 1 to 8 
Data PN9/PN9fix/PN15fix/16 bitRepeat/User File 
TTI 10, 20, 40, 80 ms 
Max. TrBk Size 0 to 5000 
TrBk Size 0 to 5000 
Max. TrBk Set No. 0 to 64 
TrBk Set No. 0 to 64 
CRC 0, 8, 12, 16, 24 bits 
Coder CC1/2, CC1/3, TC 
RM attribute 1 to 256 
BER 0.0 to 100.0%, setting resolution: 0.1% 
BLER 0 to 100%, setting resolution: 1% 

Details [TrCH Number] 
Sets the number of required TrCH (transport channels). The number of TrCh 
that can be edited varies depending on this setting. 

[Data] 
Selects the data to be inserted to Information Data of the transport channel. 
PN9fix/PN15fix is PN9/PN15 data reset at the last data of a signal. The last 
data of a signal and the first data of the next signal are not continuous. 

[Max. TrBk Size], [Max. TrBk Set No.] 
Sets the maximum TrBk Size and the number of TrBk Sets in TFCS. 

[Coder] 
Selects the channel coding type. CC1/2 and CC1/3 indicate a convolutional 
code at coding rates of 1/2 and 1/3 respectively. TC indicates a turbo code. 

[BER] 
This setting is valid when Data is set to PN9. The bits in the information 
data to be inserted to the transport channel are randomly inverted according 
to the specified error rate. 

[BLER] 
This setting is valid when Data is set to PN9. Half of the bits in the CRC to 
be added to each transport block are inverted randomly according to the 
specified error rate. 
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3.2.4 Details of setting parameters on HSUPA Edit screen 
When the Edit button in the E-DPDCH(s) frame or the E-DPCCH button 
on the main screen is clicked, the HSUPA Edit screen shown below is 
displayed. This section describes the details of the setting items on this 
screen. 

 

Figure 3.2.4-1  HSUPA Edit screen 

 

 OK and Cancel buttons 
The OK and Cancel buttons are provided to close the HSUPA Edit 
screen after performing setting. 
 

 When the OK button is clicked: 
The HSUPA Edit screen is closed, applying the settings. 

 When the Cancel button is clicked: 
The HSUPA Edit screen is closed, ignoring the settings. 
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Setting Item E-DPDCH and E-DPCCH Edit (PhyCH) 
Functional Outline Performs settings for Physical Layer E-DPDCH and E-DPCCH. 
Setting Parameters Setting Range 

HARQ Process Setting 
File 

When this check box is selected, the common 
dialog box is displayed and an HARQ process 
setting file to be used can be selected. 

E-DPCCH Data PN9, PN9fix, PN15fix, 16bit repeat, Coded 
E-DPDCH Data PN9, PN9fix, PN15fix, 16bit repeat, E-DCH 
HS-DSCH Configured No, Yes 
E-DPDCH Channel 
Codes 

SF256, SF128, SF64, SF32, SF16, SF8, SF4, 
2SF4, 2SF2, 2SF2and2SF4 
Note that 2SF2and2SF4 cannot be selected when 
Nmax-dpdch is set to 1, and SF256 and SF128 
cannot be selected when E-DCH TTI is set to 2 
ms. 

Details [HARQ Process Setting File] 
When an HARQ process setting file is used, all of the other parameter 
settings in the HSUPA Edit screen are invalid, and the values described in 
the HARQ process setting file are set to the E-DPDCH and E-DPCCH 
parameters. 

[E-DPCCH Data] 
When PN9, PN9fix, PN15fix, or 16bit repeat is selected, the selected data is 
mapped to E-DPCCH, without being coded. 
When Coded is selected, the data that is coded according to the setting of 
TrCH is mapped to E-DPCCH. 

[E-DPDCH Data] 
When PN9, PN9fix, PN15fix, or 16bit repeat is selected, the selected data is 
mapped to E-DPDCH and diffused, without being coded. 
When E-CDH is selected, the data set in E-DCH Payload Data of TrCH is 
channel-coded and mapped to E-DPDCH. 

[E-DPDCH Channel Codes] 
Sets Ch Code of E-DPDCH. Note that 2SF2and2SF4 cannot be selected when 
HS-DSCH Configured is set to Yes. When 2SF2 is selected, a channel of SF2 
E-DPDCH is mapped to each of phases I and Q. When 2SF4 is selected, a 
channel of SF4 E-DPDCH is mapped to each of phases I and Q. When 
2SF2and2SF4 is selected, a channel of SF2 E-DPDCH and a channel of SF4 
E-DPDCH are mapped to each of phases I and Q (four channels are mapped 
in total). 
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Setting Item E-DPDCH and E-DPCCH Edit (TrCH) 
Functional Outline Performs settings for transport layer of E-DPDCH and E-DPCCH. 
Setting Parameters Setting Range 

E-DCH TTI 2 ms, 10 ms. 
Pattern Length Display only. 

“5” is displayed when E-DCH TTI is set to 2 ms. 
“1” is displayed when E-DCH TTI is set to 10 ms. 

Information Bit 
Payload 

18 to 11484 (when E-DCH TTI is set to 2 ms.) 
18 to 20000 (when E-DCH TTI is set to 10 ms.) 

E-DCH RV Index 0 to 3 
E-DCH Payload Data PN9, PN9fix, PN15fix, 16bit repeat 
CRC Error Insertion Correct, Error 
E-TFCI Information 0 to 127 
“Happy” Bit 0, 1 
RSN 0 to 3 

Details [Pattern Length] 
“5” is displayed when E-DCH TTI is set to 2 ms, and “1” is displayed when 
E-DCH TTI is set to 10 ms. Display only. 

[Information Bit Payload] 
Sets the length of E-DCH payload data. 

[E-DCH RV Index] 
Sets E-DCH RV Index. The value set in this parameter is applied to all 
E-DCH RVs unless an HARQ process setting file is not used. 

[CRC Error Insertion] 
Sets whether to add an error CRC bit or a correct CRC bit to E-DCH. When 
All Error is set, an error CRC bit is added to any E-DCH. 

[E-TFCI Information] 
Sets a value of E-TFCI Information, which is E-DPCCH data. 

[“Happy” Bit] 
Sets a value of “Happy Bit,” which is E-DPCCH data. 

[RSN] 
Sets a value of RSN, which is E-DPCCH data. 
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3.2.4.1 HARQ Process Setting File 

When an HARQ process setting file is used, payload data, Ch Code, and 
other parameters of E-DPDCH and E-DPCCH can be set in detail for 
each E-DCH TTI. Since HARQ process setting files are a csv-formatted 
file, it can be edited and created using Microsoft Excel (see Figure 
3.2.4.1-1) or a text editor (see Figure 3.2.4.1-2). 

 

Figure 3.2.4.1-1  Editing HARQ process setting file using Microsoft Excel 

 

 

Figure 3.2.4.1-2  Editing HARQ process setting file using text editor 
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The HSDPA folder is created in the IQproducer folder when this software 
is installed, and an HARP process setting file HARQ Process Setting 
File.xls is stored in this folder. This file contains two types of reference 
settings for 2 ms TTI and 10 ms TTI in separated sheets. Edit 
parameters as required on the target sheet, and save the file in the csv 
format before using it with this software. In addition to HARQ Process 
Setting File.xls, the HSDFPA folder also includes other HARP process 
setting files: HARQ_process_setting_FRC1. csv.xls through 
HARQ_process_setting_FRC7. csv.xls. These files are used to facilitate 
setting in accordance with E-DPDCH Fixed Reference Channel (FRC) 
defined in 3GPP TS25.141. These files are already saved in the csv 
format, so they can be selected as HARQ process setting files as they are 
(i.e., without conversion). Note, however, that the above files contain only 
basic parameters. 

Set an HARQ process setting file according to the table below. 

Setting Item HARQ Process Setting File 
Functional Outline Performs setting for E-DPDCH and E-DPCCH. 
Setting Parameters Setting Range 

 E-DCH TTI [1] 2 ms, 10 ms 
 E-DPDCH ON/OFF [2] ON, OFF 
 HS-DSCH Configured [3] Yes, No 
 HARQ Process 1 Data to  

HARQ Process 8 Data [4] 
PN9, PN9fix, PN15fix, 16bit repeat 

 16 bit repeat value [5] 0x0000 to 0xFFFF 
 HARQ Process 1 RV (Data Retrans) 

to HARQ Process 8 RV (Data 
Retrans) [6] 

0, 1, 2, 3, 0 (Retrans), 1 (Retrans), 2 
(Retrans), 3 (Retrans) 

 E-DPDCH(s) Ch Codes [7] SF256, SF128, SF64, SF32, SF16, SF8, 
SF4, 2SF4, 2SF2, 2SF2and2SF4 
Note that 2SF2and2SF4 cannot be 
selected when HS-DSCH Configured is 
set to Yes, and SF256 and SF128 cannot 
be selected when E-DCH TTI is set to 2 
ms. 

 Information Bit Payload [8] 1 to 11484 (when E-DCH TTI = 2 ms) 
1 to 20000 (when E-DCH TTI = 10 
ms) 

 E-DPDCH(s) Gain [9] 20.00 to 20.00 dB, setting 
resolution: 0.01 dB 

 SF2 E-DPDCH/SF4 E-DPDCH [10] 20.00 to 20.00 dB, setting 
resolution: 0.01 dB 

 CRC Error Insertion [11] Correct, Error 
 E-DPCCH ON/OFF [12] ON, OFF 
 RSN Value [13] 0 to 3 
 E-TFCI Info. [14] 0 to 127 
 “Happy” Bit [15] 0, 1 
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(Cont’d) 

Setting Parameters E-DPCCH Gain Factor [16] 20.00 to 20.00 dB, setting 
resolution: 0.01 dB 

 Pattern Length [17] 1 to 2048 
Details [E-DCH TTI] 

Sets E-DCH TTI. In the sample Excel file, the HARQ process period when 
E-DCH TTI is “2ms” is set to 8 subframes, and that when E-DCH TTI is 
“10ms” is set to 4 frames. 
[#] 

Sets the E-DCH TTI number. Therefore, enter the subframe number when 
E-DCH TTI is “2ms” and enter the frame number when E-DCH TTI is 
“10ms.” 
[E-DPDCH ON/OFF] 

Set ON/OFF of E-DPDCH for each E-DCH TTI. Note, however, that 
E-DPDCH is OFF for all frames regardless of this setting, if E-DPDCH is set 
to OFF on the Uplink main screen. 
[HS-DSCH Configured] 

Sets HS-DSCH Configured. IQ mapping of E-DPDCH depends on this 
setting. Refer to the descriptions of E-DPDCH and E-DPCCH in Section 3.2.2 
“Uplink Setup screen.” 
[HARQ Process 1 Data to HARQ Process 8 Data] 

Sets payload data of E-DCH for each HARQ process. For example, when 
HARQ Process 2 Data is set to “PN9fix,” the payload data of E-DCH for 
E-DCH TTI, for which the value of RV is set by HARQ Process 2 RV (Data 
Retrans), is 
set to PN9. Similarly, when HARQ Process 2 Data is set to “PN15fix,” the 
payload data of that HARQ process is set to PN15. 
When “PN9fix” or “PN15fix” is selected, the PN code of the payload data is 
not continuous. When “PN9” is selected, the E-DCH payload data of the 
HARQ process is continuous PN9. When “16bit repeat” is selected, the bit 
string set by [16 bit repeat value] is repeated and configures the payload 
data. 
[HARQ Process 1 RV (Data Retrans) to HARQ Process 8 RV (Data Retrans)] 

Sets retransmission of the RV and payload of the HARQ process. For 
example, when HARQ Process 2 RV is set to 1 while E-DCH TTI = 2ms and 
[#] = 3, the HARQ Process 2 data is coded with RV = 1 for 3 subframes and is 
output. When “(Retrans)” is suffixed to RV, the previous payload data that 
was transmitted in the HARQ process (the data that was transmitted on the 
left cell in the same row of the HARQ process setting file) will be 
transmitted. 
[E-DPDCH(s) Ch Codes] 

Sets Ch Code of E-DPDCH. Note that 2SF2and2SF4 cannot be selected when 
HS-DSCH Configured is set to Yes. When 2SF2 is selected, a channel of SF2 
E-DPDCH is mapped to each of phases I and Q. When 2SF4 is selected, a 
channel of SF4 E-DPDCH is mapped to each of phases I and Q. When 
2SF2and2SF4 is selected, a channel of SF2 E-DPDCH and a channel of SF4 
E-DPDCH are mapped to each of phases I and Q (four channels are mapped 
in total). 
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(Cont’d) 

Details (Cont’d) [Information Bit Payload] 

Sets the length of E-DCH payload data. 
Sets the power ratio of SF2 E-DPDCH and SF4 E-DPDCH when 
2SF2and2SF4 is selected for E-DPDCH(s) Ch Codes. 
[E-DPDCH(s) Gain] 

The power that is obtained by adding the value set by this parameter as an 
offset to the value set in Power of E-DPDCH(s) on the main screen becomes 
the power of E-DPDCH(s) (or the total power of E-DPDCH channels if 
E-DPDCH(s) is a multi-code). 
[E-DPDCH(SF2) Power/ E-DPDCH(SF4) Power] 
[CRC Error Insertion] 

Sets whether to add an error CRC bit or a correct CRC bit. When “Error” is 
set, 12 bits out of CRC 24 bits are inverted and added as a CRC bit. 
[E-DPCCH ON/OFF] 

Sets ON/OFF of E-DPCCH for each E-DCH TTI. Note, however, that 
E-DPCCH is OFF for all frames regardless of this setting, if E-DPCCH is set 
to OFF on the Uplink main screen. 
[RSN Value] 

Sets a value of RSN that is transmitted on E-DPCCH. 
[E-TFCI Info.] 

Sets a value of E-TFCI Information that is transmitted on E-DPCCH. 
[“Happy” bit] 
Sets a value of “Happy Bit” that is transmitted on E-DPCCH. 
[E-DPCCH Gain] 
The power obtained by adding the value set by this parameter is added as an 
offset to the value set in Power of E-DPCCH on the main screen becomes the 
power of E-DPCCH. 
[Pattern Length] 

Sets the pattern length for each E-DCH TTI. For example, when Pattern 
Length is set to 8, a waveform pattern that consists of a repetition of data 
corresponding to “1” through “8” in the [#] row is created for E-DPDCH and 
E-DPCCH. The settings described in the [#] rows greater than Pattern 
Length in the csv file are ignored and are not used during waveform pattern 
generation. 
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3.2.5 Details of setting parameters on Channel Gain Setup screen 
When the Channel Gain Setup is selected from the Edit menu, the 
Channel Gain Setup screen shown below is displayed. This section 
describes the details of the setting items on this screen. 
Note that the Channel Gain Setup screen cannot be opened if 
UL-DPCCH is set to Off, or all Channels except for UL-DPCCH are set to 
Off on the Uplink main screen. 

 

Figure 3.2.5-1  Channel Gain Setup screen 

 

Setting Item Channel Gain 
Functional Outline Performs settings for each channel gain. 
Setting Parameters Setting Range 

DPCCH (Beta c) 0 (Switch Off) to 15 (1.0) 
DPDCH (Beta d) 0 (Switch Off) to 15 (1.0) 
Delta ACK (Beta hs/Beta c) 0 (5/15) to 8 (30/15) 
Delta NACK (Beta hs/Beta 
c) 

0 (5/15) to 8 (30/15) 

Delta CQI (Beta hs/Beta c) 0 (5/15) to 8 (30/15) 
E-DPCCH (Beta ec/Beta c) 0 (5/15) to 8 (30/15) 
E-DPDCH (Beta ed, k/Beta 
c) 

0 (5/15) to 29 (168/15) 
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(Cont’d) 
Details Sets the gain of the channels for which On is set in the Uplink main screen, 

according to the quantized waveform amplitude ratio. 
In the Channel Gain Setup screen, the E-DPDCH channel gain displayed in 
dB units indicates the total gain of all E-DPDCHs (e.g., total gain of two 
E-DPDCHs when 2SF2 is selected). Note, however, the waveform amplitude 
ratio does not match the value set in dB units if 2SF2, 2SF4, or 
2SF2and2SF4 is selected for E-DPDCH Channel Codes, because the 
waveform amplitude ratio to be set is for only one channel.  
When 2SF2and2SF4 is selected for E-DPDCH Channel Codes, the waveform 
amplitude ratio can be set for one E-DPDCH of SF4 (the value displayed in 
dB units is a total gain of E-DPDCHs of SF2 and SF4). 
When the OK button is clicked after applying settings to close the Channel 
Gain Setup screen, the settings for each item are converted to [dB] units and 
displayed in the Channel Edit screen. 
When the Cancel button is clicked, the screen is closed without reflecting the 
settings for each item on the Channel Edit screen. 
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3.2.6 Calculation screen  
Clicking Calculation & Load, Calculation & Play, or the OK button on 
the Export File dialog box will start the waveform generation.  

The Calculation screen is displayed while a waveform pattern is being 
generated. On this screen, the progress bar is displayed indicating the 
generation process of the waveform pattern and the progress of the 
waveform pattern generation. The generation of the waveform pattern 
can be stopped by clicking the Cancel button. When cancelled, it returns 
to the main screen.  

 
Progress report 

Progress bar 

Cancel button
 

Figure 3.2.6-1  Calculation Screen (In Progress) 

 

After waveform pattern generation is finished, the message “Calculation 
Completed.” is displayed in the progress window and the Cancel button 
changes to the OK button.  

When the generation is complete, you can return to the setting screen by 
clicking the OK button. After waveform generation, two files with .wvi 
and .wvd extension are output. 

 

 

Figure 3.2.6-2  Calculation Screen (Completed) 

Note: 

When using this software on MG3710A, and selecting Calculation 
& Load or Calculation & Play, the waveform generation ends 
without displaying the above screen.  
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3.2.7 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation.  

Button for selecting load destination 

 

 

Figure 3.2.7-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen. 

 

Figure 3.2.7-2  Select Memory Screen 

 

After selecting the load destination of generated waveform in the Select 
Memory screen and clicking the OK button, the Load Setting screen will 
be shown again. Click the OK button in the Load Setting screen, and 
then the loading of waveform starts.  

Notes: 

● To exit this screen without loading the waveform pattern, click 
the Cancel button in the Load Setting screen.  
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● If the configuration of generated waveform pattern used two 
memories, the Select SG screen displays just like Calculation & 
Play.  

 

3.2.8 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A. 

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 3.2.8-1  Select SG Screen 

 

3.2.9 Saving/reading parameters 
This numeric values and settings for each item can be saved in a 
parameter file by using this software. 

 Saving parameter file 

When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A 

1. Select Save Parameter File from the File menu or click the   
tool button to display the parameter file saving screen shown. 

2. Enter a file name in the File name text box and click the Save 
button to save the parameter file. 
When the save destination is not changed in the Save in box, the 
parameter file is saved in the following directory with the entered 
file name: 
X:\IQproducer\HSDPA\Entered file name.prm 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 



 

3.2 Uplink Setup Screen 

3-83 

3 

D
etailed D

escription
 of F

u
n

ction
s 

 

 

Figure 3.2.9-1  Parameter file saving screen 

 

When running on MG3710A 

1. Click the Save Parameter File button in File menu or click the   
button to display the parameter file saving screen.  

 

Figure 3.2.9-2  Parameter file saving screen (MG3710A) 

 

2. Select the folder to store the file in the Directories field, and then 
enter the name of the file using the File Name box. Click OK to save 
the parameter file. To initialize the setting in the Directories field, 
click the Default Root button. 
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 Reading parameter file 

When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A 

1. Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen shown. 

2. Select a parameter file to be read from the file list, and then click 
the Open button to read the selected parameter file. 
 

 

 

Figure 3.2.9-3  Parameter file reading screen 

 

When running on MG3710A 

1. Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen.  

 

Figure 3.2.9-4  Parameter file reading screen (MG3710A) 

 

2. Select the directory where the files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK.  
To initialize the setting in the Directories field, click the Default 
Root button. 
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3.2.10 Generating waveform pattern file 
A waveform pattern file to be used in the mainframe can be generated 
based on the setting values.  

The number of frames to be generated varies depending on the setting 
conditions for each channel, and the time required for generating a 
waveform pattern also varies accordingly. 

<Procedure> 

1. Select Calculate Waveform Pattern from the Edit menu or click the 

  tool button. 
 

At this time, the Warning message shown below appears when the 
total power is not normalized by clicking the Normalize Power button. 

 

Figure 3.2.10-1  Warning message 

 

Click the OK button to normalize the Total Power and proceed with the 
next step. 
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2. The file name input screen is displayed. 

 
File name display area

Output destination folder
selection button

Package name input box

Output file name input box

Comment input box

RRC Filter Off checkbox

 

Figure 3.2.10-2  File name input screen 

 

 Enter a package name in the package name input box, up to 31 
characters. 
Enter a file name in the file name input box, up to 20 characters 
1-byte alphanumeric characters and the following symbols can be 
used for a file name: 
! % & ( ) + = ` { } _ - ^ @ [ ] 

 When a file name is entered, the file to be generated is displayed in 
the file name display area in the following format: 

File name format: 

 test.wvi 

Extension: wvi… Information file (text format)

wvd… Data file (binary format) 
Entered file name  

 Enter a comment for the waveform pattern in a comment input box. 
Three comment input boxes are provided, and a comment can be 
entered in each line within 38 characters. 
1-byte alphanumeric characters and symbols can be used for 
comments. 

 The contents of each comment are displayed on the screen when the 
corresponding waveform pattern is selected by the Vector Signal 
Generator. Leave the comment boxes blank if not necessary. 
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 When the RRC Filter Off check box is selected, symbol data that 
does not pass through the RRC filter is generated as a waveform 
pattern. This check box needs not be selected under normal 
conditions. 

3. Click OK on the Export File screen. The Calculation screen shown in 
Figure 3.2.6-1 is displayed and waveform pattern generation starts 
(the output destination folder, package name, and file name must be 
set to start waveform pattern generation). 

 

 When started with MS269x or MS2830A and when MS269x or 
MS2830 is selected in the Select instrument screen, waveform 
pattern files generated by this application are saved in the following 
directory: 

C:\Program Files\Anritsu Corporation\Signal 
Analyzer\System\Waveform 

 

When used with MG3710A, the files are saved in the following 
directory: 

C:\Anritsu\MG3710A\User Data\Waveform 

 
In other cases, clicking the output destination selection button 
displays the Browse for Folder screen shown in Figure 3.2.10-3. The 
output destination folder can be selected from this screen. 

 

 

Figure 3.2.10-3  Browse for Folder screen 
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3.2.11 Auxiliary signal output 
When a waveform pattern generated by this software is selected by the 
mainframe, a marker signal synchronized with the RF signal is output 
from the AUX input/output connector of the rear panel as an auxiliary 
signal. Frame Pulse (Connector 1) is output. 

 Frame Pulse 
10 ms cycle pulse synchronized with the symbol at the beginning of 
the frame is output from Connector 1. The signal polarity can be 
changed by changing the polarity of Marker 1.  
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The following operations are required to output a modulated signal from 
this equipment using the waveform pattern generated by this software: 

• Transferring waveform pattern to internal hard disk 
• Loading waveform patterns from the hard disk to the waveform 

memory 
• Selecting a waveform pattern to be output from this equipment 
 
This chapter explains the details of these operations. 

 

4.1 For MG3700A or MG3710A ....................................... 4-2 
4.1.1 Transferring waveform pattern to internal  

hard disk ........................................................ 4-2 
4.1.2 Loading to Waveform Memory ...................... 4-4 
4.1.3 Selecting Waveform Pattern .......................... 4-5 

4.2 For MS2690A/MS2691A/MS2692A or MS2830A ...... 4-6 
4.2.1 Transferring waveform pattern to internal 

hard disk ........................................................ 4-6 
4.2.2 Loading to Waveform Memory ...................... 4-6 
4.2.3 Selecting Waveform Pattern .......................... 4-7 
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4.1 For MG3700A or MG3710A 
This section describes how to download a waveform pattern created for 
the MG3700A/MG3710A to the hard disk of the MG3700A/MG3710A and 
output the pattern.  

4.1.1 Transferring waveform pattern to internal hard disk 
The waveform pattern created with this software can be transferred to 
the internal hard disk in the following ways:  

Note: 
This operation is not necessary if you are using MG3710A and 
have generated waveform patterns on MG3710A.  

For MG3700A 
• LAN 
• CompactFlash Card 
 
For MG3710A 
• LAN 
• External device such as USB Memory 
 
■ Transferring from PC via LAN (MG3700A，MG3710A) 
Two IQproducerTM tools can be used to transfer a waveform pattern to 
the MG3700A/MG3710A via a LAN.  

• Transfer & Setting Wizard 
Start this wizard by clicking the Transfer & Setting Wizard button of 
this software or by selecting Simulation & Utility tab → Transfer & 
Setting Wizard from the IQproducerTM after creating a waveform 
pattern. For details, refer to Section 4.7 “File Transfer and Loading to 
Memory Using Transfer & Setting Wizard” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™).  
Transferring a waveform pattern to the internal hard disk of the 
MG3700A/MG3710A, loading the waveform from the hard disk to the 
waveform memory, and then outputting the waveform pattern can be 
done using this wizard.  
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• Transfer & Setting Panel 
This function is loaded by selecting Transfer & Setting Panel in the 
Simulation & Utility tab of the IQproducer™. For details, refer to 
Section 5.2 “Transferring Waveform Pattern” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual IQproducer™.  
Specify the folder that contains the waveform pattern to transfer to 
the MG3700A/MG3710A in the PC-side tree of Transfer & Setting 
Panel. 
 

■ Transferring using a CF card (MG3700A) 
Copy the waveform pattern (***.wvi and ***.wvd files) to be downloaded 
to the MG3700A to the root directory of a CF card.  

Insert the CF card into the card slot on the front panel of the MG3700A, 
and then copy the file to the hard disk. For details about how to use a CF 
card to transfer a waveform pattern, refer to (1) Loading waveform file in 
memory in Section 3.5.2 of the MG3700A Vector Signal Generator 
Operation Manual (Mainframe). 

■ Transferring via external device such as USB memory (MG3710A) 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MG3710A, refer to Section 7.3.6 “Copying 
external waveform pattern: Copy” in the MG3710A Vector Signal 
Generator MG3740A Analog Signal Generator Operation Manual 
(Mainframe).  
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4.1.2 Loading to Waveform Memory 
To output a modulated signal using a waveform pattern, it is necessary to 
load the waveform pattern that was transferred to the internal hard disk 
of the MG3700A/MG3710A (described in Section 4.1.1 “Transferring 
waveform pattern to internal hard disk”) to the waveform memory. A 
waveform pattern can be loaded into the waveform memory in the 
following two ways. 

■ Configuring using the mainframe  
A waveform pattern can be loaded into the waveform memory by using 
the instruction panel of the MG3700A/MG3710A or by using a remote 
command.  

For operation using the front panel, refer below: 

• Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A 
Vector Signal Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal 
Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
■ Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory by using Transfer & Setting Panel, which can be opened from 
the Simulation & Utility tab. For details, refer to Section 4.6 “File 
Transfer and Loading to Memory Using Transfer & Setting Panel” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™). 
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4.1.3 Selecting Waveform Pattern 
Select a waveform pattern to use for modulation from the waveform 
patterns loaded into the waveform memory of the MG3700A/MG3710A 
according to Section 4.1.2 “Loading to waveform memory”. A waveform 
pattern can be selected in the following two ways. 

■ Configuring using the MG3700A/MG3710A 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.  

For operation using the front panel, refer below:  

• Section 3.5.2 (4) “Outputting pattern loaded in Memory A for 
modulation in Edit mode” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 

■ Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory, and also selected for modulation. This is done by using Transfer 
& Setting Panel, which can be opened from the Simulation & Utility tab. 
For details, refer to Section 4.6 “File Transfer and Loading to Memory 
Using Transfer & Setting Panel” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducer™). 
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4.2 For MS2690A/MS2691A/MS2692A or MS2830A 
This section describes how to download a waveform pattern created for 
the MS2690A/MS2691A/MS2692A or MS2830A to the hard disk of the 
MS2690A/MS2691A/MS2692A or MS2830A and output the pattern.  

 

4.2.1 Transferring waveform pattern to internal hard disk 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MS2690A/MS2691A/MS2692A or 
MS2830A, refer below: 

• Section 2.4.4 “Copying waveform file(s) to hard disk” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.4 “Copying waveform file(s) to hard disk” in the MS2830A 
Signal Analyzer Vector Signal Generator Operation Manual 
(Operation) 

 

Note: 
Transferring waveform patterns is not required if the patterns are 
created using this software. 

 

4.2.2 Loading to Waveform Memory 
In order to output a modulated signal using the waveform pattern, it is 
necessary to load the waveform patterns stored in the internal hard disk 
to the waveform memory.  

■ Loading to Waveform Memory 
Waveform patterns can be loaded to waveform memories by operating the 
panel or by using a remote command.  

For operation using the front panel, refer below: 

• Section 2.4.1 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.1 “Loading waveform pattern(s) to memory” in the 
MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Operation) 
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For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 

• MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Remote Control) 

 

4.2.3 Selecting Waveform Pattern 
Select waveform patterns to be used for modulation from those loaded in 
the waveform memory as described in Section 4.2.1 “Transferring 
waveform pattern to internal hard disk” above. 

■ Selecting waveform pattern 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.   

For operation using the front panel, refer below: 

• Section 2.4.2 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.2 “Loading waveform pattern(s) to memory” in the 
MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Operation) 
 

For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 

• MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Remote Control) 
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A list of error messages is shown below. 

Table A-1  Error messages 

Error Message Description 
Initialization error An application initialization error occurred. 
Selection of an inaccurate file. (“File name”) The selected file type (waveform file) is invalid. 
Can not open file. (“File name”) The file cannot be opened. 

Invalid file format. (“File name”) The contents of the selected file (waveform 
information file) are invalid. 

The data of a Wave-form file is unusual. The waveform pattern data is abnormal. 
Can not write file. (“File name”) A file writing error occurred. 
Can not read file. A file reading error occurred. 
An “IQproducer” is down. 
Application is shutdown. 

The application is exited since a platform 
abnormal error occurred. 

Can not open the parameter file. (“File name”) A setting file reading error occurred. 
The Setting value is invalid Parameter name. An invalid setting value error occurred. 
The Setting value is out of range. “(Parameter 
name (minimum value – maximum value))” An out-of-range setting value error occurred.  

Total channel power except OCNS is over 0 dB. A total power error occurred. 
Channelization Code Conflicted. An orthogonal warning occurred. 
An initial parameter file was not able to be read. An initial parameter file error occurred. 
PN9 for HSDPA channels cannot be selected 
when the Process Cycle is more than 6, change 
the data except PN9. 

A process cycle setting error occurred. 

All Channels are OFF. All channels are OFF. 
Input File Name. Input a file name. 

Value is set up at 800 steps. A setting unit error occurred.   
* 800 is set as a setting unit, for example. 

Process Setting File read error. (“File name”). A process file reading error occurred. 
Pattern Setting File read error. (“File name”). A pattern file reading error occurred. 
DTCH information data is changed to the data 
truncated every one frame (PN9fix). A DTCH information change warning is alerted. 

Payload Information Data for HS-DSCH or 
Data for HS-SCCH/HS-PDSCH is changed 
to the data truncated every subframe (PN9fix). 

A HS-SCCH/HS-PDSCH information change 
warning is alerted. 

Total channel power is not normalized to 0 dB. 
It is necessary to normalize the total power when 
OCNS is OFF. 

A warning is alerted that normalization is not 
executed. 

Total channel power is not normalized to 0 dB. 
It is necessary to normalize the total power when 
Simulation is UpLink. 

A warning is alerted that normalization is not 
executed. 

Channel Edit Parameters are invalid. The parameters on the Channel Edit screen are 
invalid. 

Channel Gain Setup Error. The parameters on the Channel Gain Setup 
screen are invalid. 
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Table A-1  Error messages (Cont’d) 

Error Message Description 
DPCH information is changed to the data 
truncated every one frame (PN9fix). 

DPCH information was changed from PN9 to 
PN9fix. 

TrCH data is changed to the data truncated every 
one frame (PN9fix). TrCH data was changed from PN9 to PN9fix. 

DPCH Data and TrCH data is changed to the 
data truncated every one frame (PN9fix). 

DPCH information and TrCH data were changed 
from PN9 to PN9fix. 

The ‘parameter name' of CSV file is invalid. An illegal value is set in the HARQ process 
setting file. 

The ‘Information Bit Payload' is too large for 
‘E-DPDCH Ch Codes.’ 

The Information Bit Payload value set in the 
HARQ process setting file is too large with 
respect to the E-DPDCH Ch Codes setting value.  
Adjust the Information Bit Payload value 
according to the Information Bit Payload 
maximum value list that will be displayed along 
with the error message. 

Memory option cannot be turned on in MS269x 
mode. 

The memory option is not available for the 
IQproducerTM for MS269x. 

Note: 
This message is available only when MS269x is 
selected in the Select instrument screen  at 
startup.  
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B.1 For MG3700A and MG3710A 
The MG3700A and MG3710A has two arbitrary waveform memories from which dif-
ferent waveform patterns can be output separately. It is possible to add two signals, 
such as a desired signal + AWGN, using the baseband to be output as one RF signal. 

Note: 
If MG3710A is used as a mainframe and if adding two signals at 
baseband and outputting as one RF signal, the combination of 
baseband signal option must installed.  

When using the memories A and B individually as is in a normal case, 
however, the memory length may not sufficient for handling a waveform 
pattern with a long period that is used in a reception test. (A long-period 
waveform pattern may be caused as a result of the settings for SFN in-
cluded in BCH, or the settings for HARQ Process Cycle when [PN9]] is 
selected for the DCH data type.)  

This problem may be resolved by using the capacities of both memories A 
and B to generate a waveform pattern. This is available by switching 
memories A and B alternately as shown in Figure B.1-1 below. Note, 
however, that it is not possible to add two signals such as AWGN and in-
terference signals in this event.  

Memory (A)

Memory (B)
DAC

 

Figure B.1-1  Pattern Using FIR filter 
 

If enough data length is still not obtained though the above memory con-
figuration is configured, use the function to execute filtering processing 
using the FIR filter of the hardware incorporated in the MG3700A as 
shown in Figure B.1-2. If a waveform pattern that is filtered at data 
generation exceeds the total capacity of the arbitrary memories A and B, 
this hardware filtering function is used to automatically generate the 
waveform pattern.  

However, waveform patterns used in this configuration are not applicable 
for interference signals because the number of taps of the FIR filter is 
less than the normal waveform pattern.  
Moreover, it is also not possible to add two signals such as AWGN and 
interference signals in this event.  
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Memory (A)
= P-CCPCH

Memory (B)
= SCH，CPICH，

DPCH, etc.

FIR filter

Chip data
(3.84Msample/s)

DAC

Filtered data

 

Figure B.1-2  Block Diagram with FIR Filter Used 

 

Table B.1-1 below lists the maximum number of frames in each memory 
configuration.  

Table B.1-1  Maximum Number Of Generatable Frames For Each Condition: 
MG3700A  

ARB Memory 
Expansion 

Option 
FIR Filter Used Memory Max. No. of 

Frames 

Addition of 
AWGN and 
Interference 

Signal 

Installed 
Not used 

A or B 2330 Enabled 
A & B 4660 Disabled 

Used A & B A: 27962 
B: 6990 Disabled 

Not installed 
Not used 

A or B 1165 Enabled 
A & B 2330 Disabled 

Used A & B A: 13981 
B: 3495 Disabled 

 

Table B.1-2  Maximum Number Of Generatable Frames For Each Condition 
(Without ARB Memory Expansion Option): MG3710A 

Combination of Base-
band Signal Option FIR Filter Used Memory Max. No. of 

Frames 

Addition of 
AWGN and 
Interference 

Signal 

Installed 
Not used 

A or B 582 Enabled 
A & B 1165 Disabled 

Used A & B A: 6990 
B: 1747 Disabled 

Not installed 
Not used - 1747 Disabled 
Used - 582 Disabled 
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Table B.1-3  Maximum Number Of Generatable Frames For Each Condition (With 
ARB Memory Expansion 256M sample or ARB Memory Expansion 1024M sam-

ple): MG3710A 

Combination of Base-
band Signal Option FIR Filter Used Memory Max. No. of 

Frames 

Addition of 
AWGN and 
Interference 

Signal 

Installed 
Not used 

A or B 2330 Enabled 
A & B 4660 Disabled 

Used A & B A: 27962 
B: 6990 Disabled 

Not installed 
Not used - 6990 Disabled 
Used - 2330 Disabled 
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B.2 For MS2690A/MS2691A/MS2692A or MS2830A 
Table B.2-1 shows the number of frames that can be generated.  

Table B.2-1  Maximum Number of Frames That Can Be Generated 

RRC Filter Max. No. of Frames 
On (normal setting) 2330 
Off 6990 
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